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LEGAL NOTICES
THIS DOCUMENT CONTAINS CONFIDENTIAL AND TRADE SECRET INFORMATION OF FOCUS
ENHANCEMENTS AND ITS RECEIPT OR POSSESSION DOES NOT CONVEY ANY RIGHTS TO
REPRODUCE OR DISCLOSE ITS CONTENTS, OR TO MANUFACTURE, USE, OR SELL ANYTHING
THAT IT MAY DESCRIBE. REPRODUCING, DISCLOSING, OR USING IN WHOLE OR IN PART
WITHOUT THE SPECIFIC WRITTEN AUTHORIZATION OF FOCUS ENHANCEMENTS IS STRICTLY
FORBIDDEN.
EVERY EFFORT HAS BEEN MADE TO ENSURE THAT THE INFORMATION IN THIS DOCUMENT IS
COMPLETE AND ACCURATE AT THE TIME OF PRINTING; HOWEVER, THE INFORMATION
CONTAINED IN THIS DOCUMENT IS SUBJECT TO CHANGE.
Copyright 2005 FOCUS ENHANCEMENTS 
Unpublished All Rights Reserved
The material contained in this document is also protected by copyright laws of the United States of America
and other countries. It may not be reproduced or distributed in any form by any means, altered in any
fashion, or stored in a data base or retrieval system, without express written permission of FOCUS
ENHANCEMENTS. 
FOCUS ENHANCEMENTS cannot be responsible for unauthorized use of equipment and will not make
allowance or credit for unauthorized use or access.
Contacting FOCUS ENHANCEMENTS: 
Office Hours: Monday through Friday 8:00 AM to 5:00 PM (Central Time)
Email: support@focusinfo. com
Telephone: 763-398-1658 
Fax: 763-571-7688 
Address: Focus Enhancements, Inc. 

1370 Dell Ave. 
Campbell, CA. 95008 

WARNING: TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THIS EQUIPMENT TO RAIN
OR MOISTURE. 

IMPORTANT NOTICE
The serial number for this equipment is located on the bottom of the unit. Please write this serial number
on your enclosed warranty card and keep it in a secure area. This is for your security.

CAUTION:
This product satisfies FCC regulations when shielded cables and connectors are used to connect the unit
to other equipment. To prevent electromagnetic interference with electric appliances such as radios and
televisions, use shielded cables and connectors for connections.

NOTE:
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can be
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determined by turning the equipment off and on, the user is encouraged to try to correct the interference by
one or more of the following measures:
• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
• Consult the dealer or an experienced radio/TV technician for help. 

Information to User
Alteration or modifications carried out without appropriate authorization may invalidate the user's right to
operate the equipment. 

CAUTION:
• Use of controls or adjustments or performance of procedures other than those specified herein may 

result in hazardous radiation exposure. 
• The use of optical instruments with this product will increase eye hazard. 

THE ON/OFF SWITCH IS SECONDARY CONNECTED AND THEREFORE DOES NOT SEPARATE THE
UNIT FROM MAINS POWER IN STANDBY POSITION. 

CAUTION: TO PREVENT ELECTRIC SHOCK, DO NOT USE A (POLARIZED) PLUG WITH AN
EXTENSION CORD, RECEPTACLE OR OTHER OUTLET UNLESS THE BLADES CAN BE FULLY
INSERTED TO PREVENT BLADE EXPOSURE. 

ATTENTION: POUR PREVENIR LES CHOCS ELECTRIQUES NE PAS UTILISER CETTE FICHE
POLARISEE AVEC UN PROLONGATEUR, UNE PRISE DE COURANT OU UNE AUTRE SORTIE DE
COURANT, SAUF SI LES LAMES PEUVENT ETRE INSEREES A FOND SANS EN LAISSER AUCUNE
PARTIE A DECOUVERT.

Please read through these operating instructions so you will know how to operate your model properly.
After you have finished reading the instructions, put them away in a safe place for future reference.

IMPORTANT

CAUTION: TO PREVENT THE RISK OF ELECTRIC SHOCK, DO NOT REMOVE COVER. NO USER
SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

The lightning flash with arrowhead symbol, with an equilateral triangle, is intended to alert the user to the
presence of uninsulated “dangerous voltage” within the product’s enclosure that may be of sufficient
magnitude to constitute a risk of electric shock to persons.
The exclamation point within an equilateral triangle is intended to alert the user to the presence of
important operating and maintenance (servicing) instructions in the literature accompanying the unit.

Important Safety Instructions:
READ INSTRUCTIONS - All the safety and operating instructions should be read before the product is
operated.
RETAIN INSTRUCTIONS - The safety and operating instructions should be retained for future reference.
HEED WARNINGS - All warnings on the product and in the operating instructions should be adhered to.
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FOLLOW INSTRUCTIONS - All operating and use instructions should be followed. 
CLEANING - Unplug this product from the wall outlet before cleaning. The product should be cleaned only
with a polishing cloth or a soft dry cloth. Never clean with furniture wax, benzine, insecticides or other
volatile liquids since they may corrode the cabinet.
ATTACHMENTS - Do not use attachments not recommended by the product manufacturer as they may
cause hazards.
WATER AND MOISTURE - Do not use this product near water - for example, near a bathtub, wash bowl,
kitchen sink, or laundry tub; in a wet basement; or near a swimming pool; and the like.
ACCESSORIES - Do not place this product on an unstable cart, stand, tripod, bracket or table. The
product may fall, causing serious injury to a child or an adult, and serious damage to the product. Use only
with a cart, stand, tripod, bracket or table recommended by the manufacturer, or sold with the product. Any
mounting of the product should follow the manufacturer's instructions, and should use a mounting
accessory recommended by the manufacturer.
CART - A product and cart combination should be moved with care. Quick stops, excessive force, and
uneven surfaces may cause the product and cart combination to overturn.

VENTILATION - Slots and openings in the cabinet are provided for ventilation and to ensure reliable
operation of the product and to protect it from overheating, and these openings must not be blocked or
covered. The openings should never be blocked by placing the product on a bed, sofa, rug, or other similar
surface. This product should not be placed in a built-in installation such as a bookcase or rack unless
proper ventilation is provided or the manufacturer's instructions have been adhered to.
POWER SOURCES - This product should be operated only from the type of power source indicated on the
marking label. If you are not sure of the type of power supply to your home, consult your dealer or local
power company.
LOCATION - The appliance should be installed in a stable location.
NON-USE PERIODS - The power cord of the appliance should be unplugged from the outlet when left
unused for a long period of time.
GROUNDING OR POLARIZATION - 
• If this product is equipped with a polarized alternating current line plug (a plug having one blade wider 

than the other), it will fit into the outlet only one way. This is a safety feature. If you are unable to insert 
the plug fully into the outlet, try reversing the plug. If the plug should still fail to fit, contact your electri-
cian to replace your obsolete outlet. Do not defeat the safety purpose of the polarized plug.

• If this product is equipped with a three-wire grounding type plug, a plug having a third (grounding) pin, 
it will only fit into a grounding type power outlet. This is a safety feature. If you are unable to insert the 
plug into the outlet, contact your electrician to replace your obsolete outlet. Do not defeat the safety 
purpose of the grounding type plug.

POWER-CORD PROTECTION - Power supply cords should be routed so that they are not likely to be
walked on or pinched by items placed upon or against them, paying particular attention to cords at plugs,
convenience receptacles, and the point where they exit the product.
OUTDOOR ANTENNA GROUNDING - If an outside antenna or cable system is connected to the product,
be sure the antenna or cable system is grounded so as to provide some protection against voltage surges
and built-up static charges. Article 810 of the National Electric Code, ANSI/NFPA 70, provides information
with regard to proper grounding of the mast and supporting structure, grounding of the lead-in wire to an
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antenna discharge unit, size of grounding connectors, location of antenna discharge unit, connection to
grounding electrodes, and requirements for the grounding electrode. Refer to Fig. A.

LIGHTNING - For added protection for this product during a lightning storm, or when it is left unattended
and unused for long periods of time, unplug it from the wall outlet and disconnect the antenna or cable
system. This will prevent damage to the product due to lightning and power-line surges.
POWER LINES - An outside antenna system should not be located in the vicinity of overhead power lines
or other electric light or power circuits, or where it can fall into such power lines or circuits. When installing
an outside antenna system, extreme care should be taken to keep from touching such power lines or
circuits as contact with them might be fatal.
OVERLOADING - Do not overload wall outlets, extension cords, or integral convenience receptacles as
this can result in a risk of fire or electric shock.
OBJECT AND LIQUID ENTRY - Never push objects of any kind into this product through openings as they
may touch dangerous voltage points or short-out parts that could result in a fire or electric shock. Never
spill liquid of any kind on the product.
SERVICING - Do not attempt to service this product yourself as opening or removing covers may expose
you to dangerous voltage or other hazards. Refer all servicing to qualified service personnel.
DAMAGE REQUIRING SERVICE - Unplug this product from the wall outlet and refer servicing to qualified
service personnel under the following conditions:
• When the power-supply cord or plug is damaged.
• If liquid has been spilled, or objects have fallen into the product.
• If the product has been exposed to rain or water.
• If the product does not operate normally by following the operating instructions. Adjust only those con-

trols that are covered by the operating instructions as an improper adjustment of other controls may 
result in damage and will often require extensive work by a qualified technician to restore the product 
to its normal operation.

• If the product has been dropped or damaged in any way.
• When the product exhibits a distinct change in performance - this indicates a need for service.
REPLACEMENT PARTS - When replacement parts are required, be sure the service technician has used
replacement parts specified by the manufacturer or have the same characteristics as the original part.
Unauthorized substitutions may result in fire, electric shock or other hazards.
SAFETY CHECK - Upon completion of any service or repairs to this product, ask the service technician to
perform safety checks to determine that the product is in proper operating condition.
WALL OR CEILING MOUNT - The product should not be mounted to a wall or ceiling.
HEAT - The product should be situated away from heat sources such as radiators, heat, registers, stoves
or other products (including amplifiers) that produce heat.
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DISPOSAL - Dispose of electronics in an environmentally appropriate fashion. Do not throw in refuse
destined for landfill.

Manufacturer: Focus Enhancements
                      1370 Dell Avenue
                      Campbell, CA 95008
Model Number: FS-2/2E
Date of Manufacture: Reference the Serial Number label attached to the unit.

WARRANTY - For customers within the USA and Canada, FOCUS ENHANCEMENTS, Inc. warrants this
product against defects in materials or workmanship as follows: 

For a period of TWO years from the date of purchase, FOCUS ENHANCEMENTS, Inc. will repair or
replace the unit, at our option, without charge for parts or labor. After the period of TWO years, you must
pay all parts and labor charges.
 
The limited warranty is extended only to the original purchaser. It does not cover damage or failure caused
by or attributable to Acts of God, abuse, misuse, improper or abnormal usage, faulty installation, improper
maintenance, lightning, or other incidences of excessive voltage, or any repairs or tampering by other than
the FOCUS ENHANCEMENTS repair facility. It does not cover replacement of batteries or other
consumable parts, transportation costs or damage in transit. This warranty will become void if the serial
number or model number identification has been wholly or partially removed or erased. Repair or
replacement under the terms of this warranty do not extend the terms of this warranty. Repairs or
replacement performed outside of the warranty period will carry a warranty for 60 days from return
shipment. This warranty can not be modified by an agent of FOCUS ENHANCEMENTS, Inc. unless in
written and signed by an officer of FOCUS ENHANCEMENTS, Inc. 

Should this product prove defective in workmanship or material, the consumer's sole remedies shall be
such repair or replacement provided by the terms of this warranty. Under no circumstances shall FOCUS
ENHANCEMENTS, Inc. be liable for any loss or damage, direct, consequential, or incidental, arising out of
the use of or inability to use this product. Some states do not allow limitations on how long an implied
warranty lasts or the exclusions or limitations of incidental or consequential damages, so the above
limitations or exclusions may not apply to you. This warranty gives you specific legal rights. You may also
have other rights which vary from state to state.

Before requesting warranty or repair service, refer to http://www.focusinfo.com/support/, to review the
Trouble Shooting guidelines and the FAQs.

In the United States or Canada, to obtain warranty service, call or write the FOCUS ENHANCEMENTS,
Inc. Technical Support Line for a Return Material Authorization (RMA) number. 
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Please mark the RMA number clearly on the outside of the package. Include a copy of your sales receipt,
a brief description of the symptoms, your name, address within the USA or Canada, phone number and
any special shipping instructions. Then deliver or ship the product, postage and shipping costs prepaid, to
the address above.

For customers outside the USA or Canada, A warranty can only be offered through your dealer or
distributor and not through FOCUS ENHANCEMENTS directly, for this product. 
Please contact your dealer or distributor for repairs or technical support. Refer to http://www.focusinfo.com/
order-desk under, “FOCUS Resellers Worldwide”, for a list of International Dealers and Authorized Service
Centers.
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INTRODUCTION

CHAPTER 1
INTRODUCTION

Thank you for purchasing the Focus Enhancements
FireStore FS-2/2E DTE DV Studio Disk Recorder. 

The FS-2/2E is designed for use as a record or
playback device in studios, mobile vans and other
installations.

The purpose of this User Guide is to explain the
features and operation of the FireStore FS-2/2E.
Study the contents of this User Guide before
attempting to use your FS-2/2E. 

Check the Focus Enhancements website regularly
for updates to FS-2/2E software and
documentation:

www.focusinfo.com/support 

Alternatively, contact your Focus Enhancements
FireStore dealer/distributor.

This chapter contains the following sections:

What is a DTE Disk Recorder?
What is the FireStore FS-2/2E?
Basic Applications
Receiving, Unpacking, and Inspecting
Package Contents
Installation and Site Requirements
Mounting in a 19” Electronics Rack
Inserting the Internal 3.5” IDE Drive
Using External Disk Drives
Physical Features
Setting Up the FS-2/2E
Formatting the Drive
Setting the Time and Date
Replacing the Power Module Fuse

NOTE: The FS-2E provides even more embedded
audio SDI functionality. It includes the ability to
selectively record either channels 1 and 2 or 3 and
4 of the embedded audio of the input SDI stream. It
also provides full support of the SDI audio out. The
FS-2E inserts the recorded audio into the SDI
output stream. The FS-2 does not possess these
capabilities.

What is a DTE Disk 
Recorder? 
A DTE Disk Recorder is a device that allows you to
record or play back DV video directly to/from a
removable IDE disk drive or removable FireWire
disk drives. The FS-2/2E features analog and digital
inputs and outputs including DV25, SDI, composite,
component, S-Video, AES/EBU digital audio and
balanced analog audio. 

Audio and video are recorded to disk as a DV25
data stream in NLE native file formats.

What is the FireStore 
FS-2/2E? 
The FireStore FS-2/2E is a DTE Disk Recorder that
mounts horizontally in a standard electronics rack.
With the FireStore FS-2/2E, it is possible to:

Input DV25, SDI, composite,
component, S-Video, AES/EBU digital
audio and balanced analog audio and
record to disk in native DV25 NLE file
formats.
Playback video from disk or transcode
during recordings in DV25, SDI,
composite, component, S-Video, AES/
EBU digital audio and balanced analog
audio formats. 
Capture clips to hard disk at the
acquisition stage. There is no need to
capture them later.
Record clips to disk in DTE
Technology-based “edit-ready” file
formats such as Raw DV, AVI Type 1,
AVI Type 2, Matrox AVI, Canopus AVI,
Pinnacle AVI, QuickTime and Avid DV-
OMF. The FS-2E, and the FS-2 (with
the version 2.0 upgrade), also include
DTE support for 24P AVI Type 2
(NTSC only), and 24P Quicktime
(NTSC only).This means clips are
immediately available to your NLE
system without first having to transfer
or convert the files. 
Connect your FireWire disk directly to
your computer or connect it using
FireStore which allows mounting and
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dismounting of the drives without re-
cabling or computer re-boots.
Use the FS-2/2E's 10/100BaseT
Ethernet port to share files over a
network using FTP. The FS-2E, and
the FS-2 (with the version 2.0
upgrade), also include IP control of the
FS-2/2E. This means you can control
the FS-2/2E using a standard web
browser.
Jump from clip to clip without spooling
through tape when in playback mode.
As well as video, record and playback
embedded DV audio in 2-channel (16-
bit, 48kHz) format.
Record external timecode, embedded
timecode or create your own timecode
using Free Run, Regen or Rec Run
time code options. You can also preset
timecode and user-bit values.
Record, play and navigate using
FireStore FS-2/2E's VTR-style
controls.
Lock to your facilities Reference Video
signal during playback and record.
Record and recall a single frame of DV
video and record user definable time-
lapse sequences.
Use trick playback modes up to 30X/-
30X fast-forward and rewind speeds,
reverse play, loop clip and loop entire
disk.
Control the FS-2/2E remotely using
industry standard RS422 (Sony 9-pin),
FireWire (for starting record/pause or
AV/C) from a DV based camcorder
GPI port. You can also control the 
FS-2/2E using RS-232C (using the
optional wired remote control available
as an accessory). The FS-2E, and the
FS-2 (with the 2.0 software upgrade),
can be controlled from your web
browser using FS-2/2E IP control.
Refer to the section on FS-2/2E Web
control (“Network Setup” on page 2-
27).
Create and save multiple playlists on
the FS-2/2E. These can be shared
between different units.

Use the internal 120GB, 7200RPM,
3.5" IDE drive or daisy chain up to
eight FireWire (IEEE-1394) hard
drives (in addition to the internal
removable FSHDD-1 FireWire hard
drive) together for extremely long,
uninterrupted record times.

Basic Applications
You can use the FS-2/2E in the acquisition stage of
production, the editing/post production stage, and
the presentation stage. The FS-2/2E is most useful
in the following applications:

Presentation Video Source 
Broadcast Tape Deck Replacement
Time Lapse Recorder
Film-to-Disk Transfer
NLE/Linear Edit Source/Recorder
Endless Video Program Looping
Security Recorder/Player
Medical Recorder/Player
Web-based Video Storage
Industrial Monitoring
Video DJ and Karaoke Player
Outside Broadcast

Receiving, Unpacking, and 
Inspecting
Upon receipt of the FS-2/2E unit, examine the
shipping container. If there is evidence of damage
or rough handling, have an agent of the carrier
present when the equipment is unpacked.

Unpack the equipment carefully. Inspect it for
scratches, dents, or cracks. If the equipment is
damaged, save all packing materials and notify
both Focus Enhancements and the carrier
immediately.

Package Contents
Please take a moment to study the contents of your
FS-2/2E package. You should have the following
contents:
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One (1) FireStore FS-2/2E unit with
attached rack mounting ears
One (1) 120GB IDE disk drive in caddy
One (1) 6-pin to 6-pin FireWire cable
(for External Drive connection)
One (1) 6-pin to 6-pin FireWire cable
(for front panel port loop)
One (1) User Guide
One (1) Focus Enhancement's
Warranty Card and Statement
One (1) Focus Enhancement's
FireStore DV Conversion Suite Demo
Disk

If any of these menus are missing, contact Focus
Enhancements or your FireStore dealer/distributor
immediately.

You may need to purchase cables to connect more
than one hard disk drive to the FS-2/2E at a time.
Your Focus Enhancements dealer can help you
identify additional cables you may need.

Installation and 
Site Requirements
Focus Enhancements recommends that FS-2/2E
units be installed in a restricted access area, such
as an equipment room or closet and the installation
be performed by trained installers.

The units are designed and tested to operate
reliably between +5 - +40C (41 - 104 F).

To maintain this range, consider the following:

Air temperature surrounding the
equipment must remain within the
specified range.
Air flow around the equipment must be
sufficient to maintain proper operating
temperatures

If in doubt about the site temperature, take
measurements to be certain. If measured
temperatures fall outside the defined ambient
temperature range, you must bring the temperature
within the defined range.

Storage temperature for the units must remain
between -20 - +60C (-4 - 140 F).

Mounting in a 19” Electronics 
Rack
The FS-2/2E measures 15.89” high x 17.36” wide
by 3.47” deep. It is an 2RU chassis featuring front
rack mount ears to be installed into a standard 19”
audio/visual rack. There must be room behind the
unit for the attachment of cables.

To mount the FS-2/2E in a standard 19” audio/
visual rack, do the following:

STEP 1: Determine the desired location. The
FS-2/2E requires 3.47 vertical inches
of rack space. 
To prevent overheating, the FS-2/2E
requires a minimum of 1.75 vertical
inches of space above and below the
unit.

STEP 2: The FS-2/2E includes a pair of
universal mounting ears on the front
sides of the unit that support standard
19” audio/visual racks. Using the
provided hardware, mount the FS-2/2E
securely in the rack. 

STEP 3: Connect the FS-2/2E unit to the wall
current using the attached power cord.

Inserting the Internal 3.5” IDE 
Drive
Insert the internal 3.5” IDE drive as follows:

STEP 1: Remove the drive from its packaging.
STEP 2: Slide the drive carefully into the bay

until it is seated firmly.

Screws

Screws
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STEP 3: Press the Lock Handle flush with the
chassis face to lock the drive in place.

To remove the drive, slide the Release Lever to the
right. The Lock Handle disengages. Pull the drive
toward you to remove it.

NOTE: This drive is not intended for hot-swap
operation.

Using External Disk Drives
In addition to using a 3.5” IDE drive in the internal
slot, you can also connect any FireWire disk drive to
the HDD I/O port on the FS-2/2E. Power a single
FireWire disk drive on the FS-2/2E at any given
time. 

If you are using more than one external FireWire
drive, you must provide external power to them. It
may also be necessary to partition and format the
drives before their use with the 
FS-2/2E. Refer to “Formatting the Drive” on page 1-
9 for instructions on preparing drives before use. 

NOTE: You can “hot swap” connected external
FireWire HDDs on the FS-2/2E. This means you
can disconnect and connect drives from the system
without the need to power cycle the unit. However,
make sure the FS-2/2E is in STOP mode before
removing a disk drive.

Drive Bay

Lock Handle

Release Lever
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Physical Features
The FS-2/2E features two main surfaces, the front control panel and the rear connector panel.

Front Control Panel
The front control panel contains the seven control areas, as shown in the illustration below and described
in this section:

1 Power Rocker Switch and Power LED
This is the FS-2/2E's main power switch. This switch, although mechanical, is controlled using software. When the
power switch is set to ON and then OFF, in most cases the unit takes a moment to power down. During this time, the
FS-2/2E is ensuring that any files that have not been closed properly in a record session get closed. This prevents errors
occurring on particular files. The green LED above the power switch is ON when the unit is powered up.

2 3.5mm Headphone Jack and Volume Knob
This jack is for connecting a pair of monitor headphones. You can monitor audio of the selected input (even if E-E is not
selected) when not in record mode. When in record or playback mode, you can monitor the current audio. The
headphone jack also includes a volume control.

3 Disk Drive Bay
The disk drive bay accepts a standard 3 1/2” removable disk drive in the supplied sled. Minimum system requirements
for this drive are 7200RPM with a 2MB cache. Drive performance may vary. Focus Enhancements recommends that
you use a FireStore qualified and tested disk drive. Check the Focus Enhancements website for an updated list. This
bay is not intended for hot swap operation.

4 Edit / Utility / Input Buttons
This set of buttons contains edit, utility and input select functions for the FS-2/2E. In some cases, these buttons work in
conjunction with the FS-2/2E menus on the display. 

Input selections are either Composite, Y/C (S-Video), Component, SDI and DV. You must select the audio source for
each input in the SETUP -> AUDIO INPUT menu, the Timecode mode in the SETUP -> TC MODE menu, and the
reference video source in the SETUP-> REF VIDEO menu. For component inputs/outputs you must select the video
standard when used in NTSC mode only. Refer to “Compnt Level” on page 2-29 for more details.

5 LCD Display
The FS-2/2E LCD displays the FS-2/2E’s current status including track number, disk number, timecode, record /
playback mode as well as other information. It also displays the FS-2/2E menu system. The LCD is a green backlit
128x64 graphical display. 

6 Display Soft Keys
This set of soft buttons enables you to navigate the FS-2/2E menus. The function of the keys varies depending on what
is displayed at the base of the FS-2/2E LCD. Refer to “LCD Menu Soft Keys” on page 2-3 for more information.

7 Transport Control Keys
This set of buttons controls playback and record functions of the FS-2/2E. These functions include play, reverse play,
fast forward, fast rewind, forward frame, back frame, next track, previous track, stop, record, and so on. 

\
1

2 3 4 6

5

7
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Rear Connection Panel
The FS-2/2E rear panel, shown below, contains control /audio/video input/output areas described in this section.

You can select any of the available inputs as a source. When selected, that source is what is recorded to disk. If the unit
is in E-E mode or recording, all outputs are live with the incoming signal. 

For any particular video input, there is an associated audio input selected as a default. You can change that default to
another input utilizing the AUDIO INPUT MENU under SETUP. Refer to Chapter 2 for more information.

1 GPI : For connection of the optional wired remote control (ACSS-0019-01), the optional RS232C cable (CBLA-
0114-01) or contact closure cable.  The GPI plug accepts a 3.5mm TRS connector.

2 Ethernet 10/100 BaseT - For connecting FS-2/2E to a network or computers for file exchange, telnet, or web control.
(The web control functionality is only available for the FS-2E or the FS-2 with the 2.0 upgrade.)

3 To Computer: For connecting the FS-2/2E to a computer's FireWire 400 port.  It allows any disk drives connected
to the FS-2/2E to mount to the computer.

4 To HDD : For connecting external FireWire 400 disk drives to the FS-2/2E. Use the FS-2/2E's HDD Bypass function
with this port. When a connection is made with "Front Panel HDD Port Loop Through", it allows the front panel FireWire
connector to be used for connection of external FireWire HDDs. 

5 Front Panel HDD Port Loop Through: When patched to the "To HDD" port, this connector activates the front panel
FireWire port for connection of external HDDs.

6 DV I/O 1 and DV I/O 2: For connection of DV video devices. These two ports are used to pass through the DV
signal. The FS-2/2E does not support multiple DV inputs.

7 RS422 Control: This is the input connector for external RS422 control devices.

8 SDI Input : For connecting SDI input sources. The FS-2E provides the selection of channels 1 and 2 or 3 and 4 of
the embedded SDI audio. Refer to the AUDIO INPUT->SDI->EMBEDDED sub-menu on “Audio Input” on page 2-22.
The FS-2 does not have this capability.

SDI Output: For output to SDI devices. The FS-2E inserts two channels of audio into the SDI output stream. Only
the FS-2E has this capability.

9 Y/C Input: For connecting Y/C (S-Video) input sources.

Y/C Output: For connecting to Y/C (S-Video) devices.

10 Video Monitor Output: For connection to a video monitor (composite).   You can view the On Screen Display from
this connection.

11 Composite / Y input: For connecting composite input sources or the Y signal for component input sources.

Composite / Y Output: For output to composite devices or the Y signal to component devices (select either
composite or component form ANALOG SETTINGS in the SETUP MENU).

1

2

10

7 9

43 6
8

5 11 13

12
14

15

16 18 19

17
20
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12 Pb Input : For connecting the Pb signal from component input sources.

Pb Output: For output of the Pb signal to component devices.

13 Pr Input: For connecting the Pr signal from component input sources.

Pr Output: For output of the Pr signal to component devices

14 Sync Input: For connecting the Sync signal on non sync on green component sources.

Sync Output: For connecting the Sync signal to non sync on green component devices.

15 Timecode Input: For connecting external analog VITC timecode sources.

Timecode Output: For connection to external analog VITC timecode devices.

16 Reference Video: For reference video loop through.
To use this Reference Video input, select REF VIDEO from REF VIDEO in the SETUP menu. If the loop-through jack
is not connected, make sure the output is terminated using an external 75 ohm terminator.

17 AES/EBU Digital Audio Input and Output: For connecting AES/EBU input sources or output to AES/EBU devices.
18 Stereo Audio Monitor Output: For connection of audio monitors.

19 Balanced Analog Audio Input Channels 1 and 2: For connecting balanced analog audio input sources.

Balanced Analog Audio Output Channels 1 and 2: For output to balanced analog audio devices.

20 AC In: Use the power cord supplied to connect to the power outlet. The power module contains a protective fuse.
Refer to “Replacing the Power Module Fuse” on page 1-10 for more information.
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Setting Up the FS-2/2E
This section explains how to set up the FS-2/2E for use. Refer to the illustration below and perform the steps
on the following page.

FS-2/2E Rear Panel
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To set up the FS-2/2E, do the following:

STEP 1: Plug in the power cord.
STEP 2: Connect a Video input device.
STEP 3: Connect an Audio source (if desired).
STEP 4: Connect a Monitor if desired.
STEP 5: Connect Speakers or Headset (to

monitor the audio) if desired.
STEP 6: Connect a Tape Drive if desired.
STEP 7: Connect a Time Code Generator if

desired.
STEP 8: Connect an External Control Device

(RS422) Device if desired.
STEP 9: Connect a Reference Video signal if

desired.

Formatting the Drive
Use this procedure to format the FS-2/2E internal or
connected external disk drives when not yet
formatted.

STEP 1: From the Utilities Menu, select
FORMAT DISK as shown below.
When you make this selection, the fol-
lowing screen appears:

STEP 2: Select between volumes by pressing
the | and |  buttons. 
• When you select the volume and 

press YES, the following screen 
appears:

• When you select YES, a message 
indicating that the formatting is 
progressing appears.

STEP 3: Press EXIT to return to the menu
screen.

WARNING: FORMAT ERASES ALL DATA ON
THE DISK DRIVE!

Setting the Time and Date
Before using the FS-2/2E, use this procedure to set
the time and date.

STEP 1: Select the Setup Menu.
STEP 2: Select SET DATE & TIME. The

following screen appears.

STEP 3: Select SET DATE or SET TIME and
press SEL to open the sub menu as
shown below.

FORMAT DISK
VOLUME 1? :
SIZE 115GB
FREE 540 MIN

EXIT YES NO

FORMAT WILL
ERASE ALL DATA!! :
CONTINUE FORMAT
VOL 1?

EXIT YES NO

SET DATE
SET TIME

EXIT SEL

SYSTEM DATE
02/24/02
MM/DD/YY
 |  & | 
MOVES CURSOR

EXIT

SYSTEM TIME
16:21:13
Hh:Mm:Ss
 |  & | 
MOVES CURSOR

EXIT
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STEP 4: Scroll from value to value using the
FORWARD and BACK INDEX
Buttons.

STEP 5: Press  and  to scroll through digits
in the value. 

STEP 6: Press EXIT to return to the menu
screen. 
Regardless of the display, the file
name always remains YYYYMMDD-
HHMMSS.xxx (Year-Month-Date-
Hour-Minute-Second).

Replacing the Power Module 
Fuse
The power module of the FS-2/2E contains a
protective fuse. 

To replace the fuse do the following:

STEP 1: Turn off the FS-2/2E.
STEP 2: Locate the power module on the rear of

the unit. It is indicated as “AC In.”
STEP 3: Detach the power cord from the power

module.
STEP 4: Locate the small recess on the top of

the power module above the power
switch.

STEP 5: Use a small tipped standard
screwdriver to pop open the fuse door.

STEP 6: Once open, slide the white fuse carrier
out of the unit.

STEP 7: Replace the fuse with a 1.6 amp 250V
slow blow fuse.

STEP 8: Reassemble the fuse carrier and slide
it back into the unit.

STEP 9: Replace the fuse box door.
STEP 10: Re-attach the power cord.
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CHAPTER 2
FS-2/2E FUNCTIONS

This chapter contains the following sections:

Edit/Utility/Input Buttons
LCD Menu Soft Keys
Transport Control Keys
LCD Display
FS-2/2E Menus and Functions

Edit/Utility/Input Buttons
To the right of the hard disk drive are a bank of 15
buttons as shown below.

The first row contains five buttons that
are Edit functions keys. 
The second row consists of five
buttons that are Utility keys. 
The third row has five buttons that are
Input buttons.

Edit Function Keys
This section explains the edit function keys.

MARK IN - Mark In Key

Use the MARK IN key to mark a particular frame as
a starting point when creating a clip for a playlist.
Refer to “Playlist Menu” on page 2-15 of this user
guide for more information about Playlists.

NOTE: It is only possible to mark in and out points
during playback.

MARK OUT - Mark Out Key

Use the MARK OUT key to mark a particular frame
as an ending point when creating a clip for a playlist.

NOTE: Once you have selected In and Out points,
press the PLAYLIST key. (The In and Out key lights
will turn off). You are then free to add more clips to
the playlist by again selecting In and Out points.
When finished, go to the PLAYLIST menu under
SETUP.

PLAYLIST – Add to Playlist key
Press this key during stop or play to add a current
clip to the playlist.

Once In and Out points have been selected, press
this key to add selected clips to the playlist.

KEEPER - Keeper Key
By pressing the Keeper key during a recording, you
can mark each clip into the KEEPER folder on disk. 

To add all KEEPER clips to the KEEPER folder on
the disk drive, select UTILITIES->ORGANIZE CLIP
from the FS-2/2E menu.

FOLDER - Folder Key
By pressing the Folder key during a recording, you
can mark each clip into particular pre-named
folders on disk (up to 10 folders can be prenamed).
Default names for the folders are 0 through 9. Refer
to “How to Mark Scenes” on page 3-7 of this user
guide to set up Scene Marking folders). 

By repeatedly pressing the FOLDER key, you can
scroll though the available folders. You can also
assign clips to folders using the numeric keypad on
the optional remote control units. The current clip
can be marked during recording, playback or in stop
mode. Once selected, the clip is marked for
placement into that particular folder. 

To add all marked clips to their respective folders on
the disk drive, select UTILITIES -> ORGANIZE
CLIP from the FS-2/2E menu.

For more information on SCENE MARKING, refer
to “How to Mark Scenes” on page 3-7 of this user
guide.

If the FOLDER key is lit during playback, the 
FS-2/2E PLAY FROM mode is set to FOLDER.

MARK IN MARK 
OUT

PLAY 
LIST

KEEPER FOLDER

OSD HDD LOCK REMOTE E-E

CMPST Y/C CMPNT SDI DV

MARK
IN

MARK 
OUT

PLAY
LIST

KEEPER FOLDER
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Utility Function Keys
This section explains utility function keys.

OSD - (On Screen Display)
Press this key to enable on screen display on the
monitor output (composite). When off, the key will
not light.

HDD – Hard Disk Drive Bypass Key
Press this key to immediately open the HDD
Bypass confirm screen as described in the HDD
Bypass section of the Menu. For more information,
refer to “HDD Bypass” on page 2-18

LOCK – Keypad Lock Key
This key turns lock on or off. When the key is lit, the
keypad is locked. When off, it is not locked.

REMOTE – Remote Key
When you press this key, the FS-2/2E goes directly
to the REMOTE mode as described under the
Control Modes menu. The key lights in Local mode.
When in the FS-2/2E is in remote mode, you cannot
use front panel keys for operation.

Another press exits REMOTE mode and the
backlight turns off.

E-E – Electronic to Electronic Key
When you press this key, the selected input is
passed on to all outputs on the FS-2/2E. The E-E
mode is only active when the FS-2/2E is in STOP
mode.

Input Source Selection Keys
This section explains input source selection keys.

In all cases, when selected, the key lights. When
selecting CMPST, Y/C, or CMPNT and there is no
video source available, this light flashes several
times and then the FS-2/2E returns to the original
input selection. Switching is not seamless. You
cannot change inputs while in record mode.

CMPST – Composite Video Source Input Key
Press this key to select composite video as the
input source. If there is no video source available
when this button is pressed, the light flashes
several times and then the FS-2/2E returns to the
original video selection.

The default audio link is balanced analog audio.
You can also select AES/EBU audio as the input
link in the SETUP->AUDIO INPUT menu. 

Y/C – S-Video
Press this key to select S-Video (Y/C) as the input
source. If there is no video source available when
this button is pressed, the light flashes several
times and then the FS-2/2E returns to the original
video selection.

The default audio link is balanced analog audio.
You can also select AES/EBU audio as the input
link in the SETUP->AUDIO INPUT menu.

CMPNT – Component Video Source Input Key
Press this key to select Component video (Y, R-Y,
B-Y) as the input source. If there is no video source
available when this button is pressed, the light
flashes several times and then the FS-2/2E returns
to the original video selection.

The default audio link is balanced analog audio.
You can also select AES/EBU audio as the input
link in the SETUP->AUDIO INPUT menu.

SDI Serial Digital Video Source Input Key
Press this key to select SDI video (SMPTE 259M)
as the input source. 

The default audio link is embedded AES/EBU
digital audio in the stream. You can also select
either balanced analog audio or separate AES/EBU
audio as the input link in the SETUP->AUDIO
INPUT menu. 

The FS-2E provides the option to select either
channels 1 and 2 or 3 and 4 of the embedded audio
of the SDI stream. Refer to the SETUP->AUDIO
INPUT->SDI->EMBEDDED sub-menu on page 2-
22.

DV Video Source Input Key
Press this key to select DV video (25Mb/s) as the
input source. 

OSD HDD LOCK REMOTE E-E

CMPST Y/C CMPNT SDI DV
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The default audio link is embedded 2-channel
digital audio in the stream. You can also select
either balanced analog audio or AES/EBU audio as
the input link in the SETUP->AUDIO INPUT menu.

LCD Menu Soft Keys
These three keys below the FS-2/2E LCD display
are soft keys for navigating and selecting items in
the FS-2/2E menu.

These keys are also used for selecting different
display modes. They are called soft because their
function changes depending upon what is displayed
on the LCD above the particular key.

NOTE: In some cases when navigating the FS-2/2E
menus, you can use the right soft key to scroll down
through the menu. To scroll up, just hold down the
SHIFT key as well as the right soft key.

Transport Control Keys
This set of buttons controls playback and record
functions of the FS-2/2E. These functions include
play, reverse play, fast forward, fast rewind, forward
frame, back frame, next track, previous track, stop,
and record. This area also features hot keys for
changing, controlling, and navigating the FS-2/2E
menu system. Each of these keys is described
below as shown in order left to right, top to bottom.

MENU Key
Press this key to launch the FS-2/2E menu system.
Once pressed, the Menu screen appears on the 
FS-2/2E LCD and the button lights. If you press the
MENU key while in a particular screen in the menu
system, that menu is marked and the MENU key
lights. You can then EXIT the menu and perform

other functions. If you press the MENU key at
anytime, you will return to the marked MENU
(except if you are in REC mode).

|  Back Index Key
Press this key to return to the beginning of the
current clip if in playback mode. Press it twice to
return to the previous clip during playback. In Stop
mode press it to return to the beginning of the
previous clip. If you press SHIFT and Back Index,
the previous disk drive is selected.

| Forward Index Key
Press this key to skip forward to the next sequential
clip for playback. If you press SHIFT, the forward
index goes to the next disk drive.

 Stop Key 
Press this key to stop the selected mode and return
the FS-/2E to Pause. Press it again to put the FS-2/
2E into STOP (standby with menu screen). The
splash screen is the first frame of the selected clip
when you select SETUP->STOP OUTPUT->CLIP
PREVIEW. When the FS-2/2E is in Stop mode, the
key lights.

 Play Key
Press this key to start playback of the selected clip.
If you press the SHIFT key plus the PLAY button,
the FS-2/2E immediately goes into reverse play
mode. 

 Record Key (Red)
Press this key once when the FS-2/2E is in STOP
mode and the FS-2/2E goes into REC-PAUSE. The
REC button flashes. Press it again to start
recording. If you press REC during a recording, the
current clip is closed and a new clip is created
without dropping any frames. This key is the only
key that is RED on the front panel.

If you press REC and SHIFT simultaneously, the
FS-2/2E captures a single frame of video. In a
particular session, all single frames of video are
saved as part of the same clip on disk.

SHIFT Key
Use the SHIFT key to give particular keys a
secondary functionality. When you press it, the
SHIFT key lights and remains in SHIFT mode until

MENU | |

SHIFT
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the button is released. The SHIFT mode of
particular keys is listed below that key or displayed
on the FS-2/2E LCD.

 Back Search Key
Press the Back Search button to allow video to be
played at different speeds (both slower and faster
than real-time). Refer to the note under “Forward
Search Key” for more information.

 Forward Search Key
Press the Forward Search button to play video at
different speeds (both slower and faster than real-
time). 

NOTE: Pressing the FF Search button multiple
times results in increases in the search speed. This
mode is bidirectional in forward X times normal
search speed. Press the Back Search button to
cause the FF speed to slow down by one step.

For instance, if you are in 10X FF speed and you
press the Back Search button once, you are in 2X
FF mode. This also applies to backward search
speeds. The default speed resolution is as follows
(NTSC and PAL have slightly different multiples for
both greater and less than 1X play speed):

REVERSE: -30X, -10X, -2X, -1X
(reverse play), -1/2X(-15fps), Still.
FORWARD: Still, +1/2X (+15fps), +1X
(play), +2X, +10X, +30X

Standard Forward Search and Reverse Search
also have a “higher resolution” mode where more
speeds are available as follows: 

REVERSE: -30X, -25X, -18X, -15X, -
12X, -10X, -8X, -5X, -4X, -3X, -2X, 
-1/30, -1/15, -1/10, -1/6, -1/5, -1/3,-1/2
FORWARD: +30X, +25X, +18X, +15X,
+12X, +10X, +8X, +5X, +4X, +3X,
+2X, +1/30, +1/15, +1/10, +1/6, +1/5,
+1/3, +1/2

This mode can be set in the SETUP->FF / RW HI
RES menu in the FS-2/2E Setup Menu. Once set,
these speed resolutions become the default when
you press Fast Backward or Fast Forward.

LCD Display
The FS-2/2E LCD screen displays different 
FS-2/2E modes and states. On boot up, the 
FS-2/2E displays the following screen:

Depending on the connected disk drive, the 
FS-2/2E may or may not display “Please Wait”
during boot up.

Once booted, if no disk drive is connected to the
FS-2/2E (either through the internal slot or
externally using the HDD I/O port), the following
screen appears:

Insert a drive into the front panel drive bay or
connect a FireWire disk drive to the HDD I/O port. 

If you received a drive from Focus Enhancements,
it should be configured and ready to use. If the
message “No Disk Detected” appears, make sure
the drive is inserted properly. 

If the message “No Format Detected” appears, you
must partition and format the inserted drive before
use. The FS-2/2E prompts you through the steps
required to perform a format.

WARNING: Formatting and partitioning erases all
data on a disk!

WELCOME
TO FIRESTORE2-E!

PLEASE WAIT....

NO DISK
DETECTED!

MENU
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Once ready for use, the FS-2/2E default Menu
Screen appears as follows:

(1) Play/Record Status Symbol 
This symbol displays a graphical representation of
the current FS-2/2E state as follows:

 - STOP

,  - Play or Reverse play

 - Fast Forward search and speed

 - Fast Back Search and Speed

l - Record and Record Mode

|| - Pause

NOTE: Each symbol has multiple display modes.
For a complete list, refer to “FS-2/2E LCD Display
Modes” on page 4-3 of this user guide.

(2) Record/Play Status Indicator 
In this space, the FS-2/2E displays a character that
indicates what record or playback mode it is in. The
characters displayed and their respective modes
are listed in “FS-2/2E LCD Display Modes” on
page 4-3 of this user guide.

(3) Current System Status 
The current system status of the FS-2/2E is
displayed in the top left corner of the LCD display.
For instance, it displays whether the FS-2/2E is in
record, play, stop, pause, fast search or slow
motion modes.

(4) Volume Number 
The volume or disk number of the current clip
recording or playback session is displayed in the
top right corner of the LCD display. For example, a
display value of “2-014” identifies a track as being
on volume 2.

(5) Track or Clip Number 
The track number is displayed in the top right corner
of the LCD Display. This is the current clip or track
number being recorded or played back. For
example, a display value of “2-014” identifies a track
as being clip 14 on volume 2.

(6) Timecode/User Bit Display Mode 
This identifies the display mode for timecode or
user bit values. Selections are:

COUNTER - Counts frames during
record or playback of the current clip
only.
REMAINING - Counts down the
number of frames available (time) on a
particular disk during a record session.
In a playback session, this display
shows the remaining time on the
current clip.
DV NTSC or PAL - Displays the
external timecode value being
generated by a camcorder or other
device during a record session.
Timecode mode has to be set to EXT
TC for this function to operate (refer to
“TC Mode” on page 2-22 of this user
guide). In playback mode, this displays
the embedded DV timecode value in a
particular track.
USER BIT - Displays the set user bit
value in a particular clip. A user bit
value must be added for this to display
(refer to “TC Set” on page 2-23 of this
user guide).
ABSOLUTE - Displays an absolute
timecode value for the particular
session (sum of all COUNTER
timecodes on connected volumes).
This is primarily used when you set the
FS-2/2E to AV/C mode and are
controlling it with an external FireWire
device, such as a computer.

1

2 3 4 5

6
7
8 9

10

11 12 13
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NOTE: The FS-2/2E will not accept
NDF TC values in DF TC mode.
AUDIOMETER - Displays left and right
levels in db. The scale indicates -10db,
-4db, and 0db. This display mode is
only available for the FS-2E, or the FS-
2 (with the 2.0 upgrade).
The 2 lines on the menu appear similar
to the following:

-10 -4 0

 |  |  |

R------------------

L-----------------

(7) Timecode or User Bit Value 
Displays the timecode or user bit value of display
mode selected as follows:

00;00;00;00 - Drop Frame
00:00:00:00 - Non Drop Frame

(8) Current Disk Volume 
Displays the current disk volume in relation to
available space.

(9) Available Space on Volume 
Displays the space in time available on the current
volume, for example,

DISK 1 183min - Current Disk time
remaining is 183 minutes
NO DISK - No attached Disk

(10) Folder Display 
In record or playback, this displays the particular
folder a clip is in (if applicable). If playing an entire
folder (PLAY FROM menu set to particular folder),
it displays the folder name as follows: [FOLDER].

(11) Soft Key One (MENU) Function Display 
Displays the current function related to Soft Key one
(left key on the top row of buttons). You can use this
key for opening the FS-2/2E Menu and also as a
STOP key during a recording.

(12) Soft Key Two (DISP) Function Display 
Displays current function of Soft Key two (middle
key on the top row of buttons). This changes the TC
display between COUNTER, REMAINING, DV TC
(NTSC or PAL), USER BIT, and ABSOLUTE when
in record or playback modes. For the FS-2E, or the
FS-2 with the 2.0 upgrade, there is an additional
AUDIOMETER display mode.

(13) Soft Key Three (SHFT) Function Display 
Displays current function of Soft Key three (right key
on the top row of buttons).
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FS-2/2E Menus and Functions
The FS-2/2E features a comprehensive menu
system which allows a number of features to be
initiated and setup. The menu system contains the
following selections:

RECORD MODE 
• NORMAL REC
• RETRO DISK
• RETRO CACHE
• LOOP RECORD
• STILL
• TIME LAPSE
CONTROL MODE
• LOCAL (selections include: 

NORMAL, INDEX AT TC, INDEX 
AT SCENE)

• REMOTE
• AV/C (selections include 

NORMAL, INDEX AT TC, INDEX 
AT SCENE)

• SYNCRO SLAVE (selections 
include NEW FILE [for FS-2E, or 
FS-2 with 2.0 upgrade only], 
SAME FILE [for FS-2E, or FS-2 
with 2.0 upgrade only])

PLAY MODE
• PLAY CLIP
• LOOP CLIP
• LOOP ALL
• PLAY ALL
PLAY FROM MODE
• TRACK LIST
• PLAY LIST
• FOLDER LIST (selections include: 

NONE, KEEPER, 0, 1, 2, 3, 4, 5, 
6, 7, 8, 9)

PLAYLIST
• OPEN
• SAVE
• NEW 
• EDIT (selections include 

REMOVE CLIP, INSERT CLIP, 
and MOVE CLIP).

• VIEW
• DELETE LIST
HDD BYPASS
INTERNAL HDD
RECORD FORMAT
• RAW DV
• AVI TYPE 1
• AVI TYPE 2
• CANOPUS AVI
• MATROX AVI
• QUICKTIME
• AVID OMF
• PINNACLE
• 24P AVI TYPE 2 (for FS-2E, or 

FS-2 with 2.0 upgrade only)
• 24P QUICKTIME (for FS-2E, or 

FS-2 with 2.0 upgrade only)
SETUP
• SET DATE & TIME (sub-menus 

include SET DATE, SET TIME)
• OS VERSION NO
• OS UPGRADE
• PAL/NTSC (selections include 

NTSC, PAL)
• RS422 REMOTE

• TYPE (selections include 
BVW-75, GENERIC)

• TC SOURCE (selections 
include ABS, DV, COUNTER)

• COMPOSITE (selections 
include BALANCED and AES/
EBU)

• AUDIO INPUT
• COMPOSITE (selections 

include BALANCED AND 
AES/EBU)

• Y/C (selections include 
BALANCED, AES/EBU)

• COMPONENT (selections 
include BALANCED, AES/
EBU)

• SDI (selections include 
EMBEDDED, BALANCED, 
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AES/EBU)
• DV (selection is EMBEDDED)

• AUDIO IN LEVELS
• TC MODE

• EXT TC (selections include 
SELECTED INPUT, VITC 
REFERENCE, VITC 
ANALOG, LTC, EMBEDDED 
DV, EMBEDDED SDI

• REC RUN
• REGEN
• FREE RUN

• TC SET
• TC PRESET
• UB PRESET
• TC DELAY (FS-2E only)
• DROP/NON-DROP (sub-

menus include DROP, NON-
DROP)

• ON SCREEN DIS (sub-menus 
include ABS, TC, MENU, OFF)

• FF/RW HI RES (sub-menus 
include ENABLE, DISABLE)

• GPI PORT (sub-menus include 
DISABLE, PAUSE/UNPAUSE, 
INDEX/NEW FILE, REC 
SNAPSHOT

• BACKLIGHT (selections include 
ON, OFF, AUTO OFF)

• STOP OUTPUT (selections 
include GRAY, NO OUTPUT, CLIP 
PREVIEW, CUSTOM)

• AUDIO CORRECT (selections 
include OFF, MEDIUM, HIGH)

• PREFERENCES (selections 
include SAVE, RESTORE)

• FOLDER PREF (selections 
include SCENE MARK and AUTO 
MARK)

• ANALOG OUT (selections include 

COMPOSITE, COMPONENT)
• NETWORK SETUP 

• IP SETTINGS (selections 
include DHCP, CUSTOM IP)

• USER/PASSWORD
• VIEW IP INFO
• SERVICES (selections include 

FTP [ENABLE/DISABLE], 
TELNET [ENABLE/DISABLE], 
WEB [ENABLE/DISABLE])

• REF VIDEO (selections include 
REFVIDEO, FREE RUN)

• VIDEO OUT ADJUST
• COMPOSITE Y/C (selections 

include HUE, SATURATION, 
BRIGHTNESS, CONTRAST, 
SC PHASE, H PHASE, 
BLACK LEVEL, 0, 7.5

• COMPONENT (selections 
include Y, PB, PR, H PHASE, 

• COMPNT LEVEL 
• INPUT (selections include 

SMPTE, BETA, MII 
• OUTPUT (selections include 

SMPTE, BETA, MII
UTILITIES
• ORGANIZE PINN
• ORGANIZE CLIP
• ORGANIZE OMF
• DELETE CLIP
• FORMAT
• PARTITION
• REPAIR (selections include 

CHECKDISK, CURRENT CLIP)
• FILE NAME
• FACTORY RESET
• DIAGNOSTIC

Each of these selections is explained in this
chapter.
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To enter the FS-2/2E MAIN MENU, press the
MENU key or soft key 1 (MENU) while in Stop
mode. The following MENU SCREEN appears:

Menu Items
The four line list indicates the currently highlighted
menu item. Push soft key 3 (under the  symbol) to
see more selections. To scroll up through the menu,
press SHIFT + soft key 3.

Sub-Menu Available
The  symbol at the end of a line indicates a menu
item that has a sub-menu available. Press the SEL
Soft Key, to display the sub-menu.

Soft Keys
EXIT -- Press EXIT to return to the 
FS-2/2E MAIN MENU screen.
SEL -- Press SEL to select the current
menu item. If a sub-menu is available,
it will open. 
Scroll Arrow -- The  or  symbol
allows you to scroll up or down through
menu items. 

Record Menu
The FS-2/2E RECORD MENU allows you to enable
different record functions. 

Select the mode. by pressing SEL to
open the sub menu. 
Press EXIT to exit back to the menu
screen. 

Once you select a particular mode in the Record
Mode menu, the FS-2/2E remains in that mode until
select a different mode.

Available items in the RECORD MENU are:

NORMAL REC 
RETRO DISK 
RETRO CACHE
LOOP RECORD
STILL
TIME LAPSE 

NOTE: When an inserted or attached HDD is nearly
full, in some record sessions, the HDD time
remaining may display “001min” remaining. If you
press RECORD, the FS-2/2E sometimes displays
NO SPACE LEFT. Focus Enhancements advises
that when a disk drive is close to being full, you
make sure other disk drives are readily available in
order to avoid lost footage.

Normal Record
This is the standard and default record mode. When
you press REC, the FS-2/2E begins standard
recording. Press the REC once to put the FS-2/2E
into REC PAUSE mode. Press it again to put the
FS-2/2E into RECORD mode. 

Press STOP once to pause your recording. To
STOP the recording session entirely, press STOP
once again. Use the REC button to restart the
recording.

Retro Disk 
RETRO DISK Record constantly buffers video in a
loop to a determined amount of space on the hard-
disk drive so that when record is triggered, a retro
time period can be added to the beginning of any
clip. You can select the RETRO DISK value to close
the available disk drive space.

Set RETRO TIME by pressing the 
and  buttons. Time is selectable in
one minute increments. 

RECORD MODE
CONTROL MODE
PLAY MODE
PLAY FROM

EXIT SEL

RETRO DISK
HDD AVAIL:

183 MIN
RETRO TIME:

15 MIN
EXIT
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Hold the button for more than 3
seconds to allow numbers to increase
by 10 times. 
Press EXIT to return to the RECORD

Press the REC key when in RETRO DISK mode to
put the FS-2/2E into a RETRO DISK state (the FS-
2/2E's REC button flashes as if in PAUSE state).
The FS-2/2E is actually recording in this state, but
until you press the REC key a second time, the
video records over itself in a continuous loop.
RETRO DISK always keeps at least the selected
amount of time in a series of one minute clips. For
instance, if you set the RETRO DISK value to 3
minutes, the FS-2 always has 3 minutes (made up
of three, one (1) minute clips) of video saved to disk.
As the recording goes past the 3 minute point, a
fourth clip is created. Once that clip reaches one
minute, the oldest of the previous 3 clips is deleted.
Another fourth clip is then created. 

If you select a RETRO session that is 60 minutes or
greater, instead of one minute clips, the FS-2/2E
creates 9 minute, 13 second clips (2GB clips on
disk). The functioning of RETRO DISK remains the
same. The larger file size prevents the FS-2/2E
from reaching its 999 track limitation for very long
RETRO records. 

Due to larger files sizes, the maximum amount of
drive space available is decreased to
accommodate the last recording in a session. For
instance, if you have 90 minutes of disk space
remaining, after you set RETRO record to less than
60 minutes, the available space changes to 88
minutes of available disk space. 

If you set RETRO time to 88 minutes, the recording
will be made up of about nine and a half 9 minute,
13 second clips. There must be space available in
this situation in order to record the final clip which
eventually will write over clip 1. This ensures that at
any given time, at least 88 minutes of video exists
after a complete RETRO DISK record loop.

NOTE: The FS-2/2E must always have at least one
minute of disk space (under 60 minutes) or 9
minutes, 13 seconds of disk space (when the
RETRO DISK value is set to greater than 60
minutes) remaining in addition to the RETRO DISK
value, in order to function correctly. For instance, it
is not possible to set a RETRO DISK value of one
minute if only one minute of disk space remains.

Once RETRO DISK time is set, you can exit the
Menus and return to the Main Screen. An “L” will
now appear next to the record symbol on the 
FS-2/2E's display. Press the REC key once to put
the FS-2/2E immediately into RETRO DISK
RECORD. Clips are being recorded to disk for X
number of minutes in one or nine minute increments
(each as a separate track).

The REC button flashes (as when the unit is in
pause). When you press the REC key, the FS-2/2E
leaves RETRO DISK mode and goes into standard
record.

All one minute tracks in the recorded loop sequence
appear and are saved as their own tracks on disk
(for example, 1-001, 1-002, 1-003, and so on)
except for the recording that was in progress, which
takes on the characteristics of a standard track. At
this stage, the FS-2/2E is essentially in standard
record mode (the “L” on the display disappears). No
frames are lost across tracks during the record
session. 

Once paused, the unit returns to RETRO DISK
record mode again (the “L” reappears in the LCD
and viewfinder) for further RETRO recordings or
until it is disabled in the RETRO DISK screen.

RETRO DISK can be used in LOCAL and SYNCRO
SLAVE record control modes. 

WARNING: Make sure FS-2/2E is in STOP mode
before removing the disk drive from the system. Do
not attempt to remove it when the FS-2/2E is in
REC or REC-PAUSE mode.

Retro Cache 
RETRO CACHE Record constantly caches your
video in a loop up to a 10 second data buffer. In this
way, when the record is begun, a retro time period
is added to the beginning of any clip.

RETRO CACHE
CACHE: 10 sec

EXIT
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Pressing the REC key when in RETRO CACHE
mode puts the FS-2/2E into a RETRO CACHE state
(the tally light on the FS-2/2E flashes as if in PAUSE
state). The FS-2/2E is actually recording in this
state, but until you press the RECORD key a
second time, the video records over itself in a
continuous loop. It is much the same as RETRO
DISK recording, except that it utilizes a data buffer
separate to the disk drive to cache video. 

RETRO CACHE is also accurate down to the frame
instead of the 1 minute clips used in RETRO DISK.
Once a RETRO CACHE value is set, pressing the
REC key once puts the FS-2/2E immediately into
RETRO CACHE Record. A “C” now appears next to
the record symbol on the FS-2/2E's display. 

Video is being recorded to the FS-2/2E cache. The
REC button flashes (as if the unit is in pause). When
you press the REC key, the FS-2/2E leaves the
RETRO CACHE record mode and goes into
standard record (the “C” on the display disappears). 

Any clip recorded in this mode has the contents of
the cache added to the beginning of the clip. 

Once paused, the unit returns to the RETRO
CACHE record mode again (the “C” reappears in
the LCD) for further RETRO CACHE recordings or
until it is disabled in the RETRO CACHE by setting
the RETRO CACHE time to zero seconds.

RETRO CACHE record can be used in LOCAL and
SYNCRO SLAVE record control modes.

Loop Record
When you select LOOP RECORD when recording
has begun, video is recorded to available disk
space. Clips are recorded to disk continuously in
one-minute clips (up to 60 minutes), or 9 minute
clips (for loops over 60 minutes, 2GB files).

When the disk capacity’s record time is reached, an
additional one-minute (or 2GB) segment is created.
After this clip is complete, the oldest one-minute clip
(or 2GB segment) is recorded over, followed by
each sequential oldest clip.

When you press STOP during a record session,
recording stops and clips in the current LOOP
RECORD session are saved to disk. They are also
saved in a single folder.

NOTE: Loop record only works with one disk drive.

Still
When you select STILL when REC has begun, a
single frame is grabbed.

You can grab a still quickly by pressing SHIFT +
REC on the front panel when you are in any record
mode.

Use STILL with LOCAL and SYNCRO SLAVE
record control modes. If STILL is the record mode
when power is cut to the unit or it is turned off, and
then rebooted, the FS-2/2E goes to NORMAL REC
mode.



FS-2/2E FUNCTIONS 

 FS-2 and FS-2E Studio DTE Disk Recorders User Guide
2 - 12

Part Number: MANL-0927-03

Time Lapse
You can select an interval of up to twenty-four
hours. The interval is the period of time between the
FS-2/2E capture of a single frame of video (a value
of 00:00:00:00 means no frames will be recorded).

Set REC INTERVAL by pressing the
TIME  and  buttons. Select the
time in frames (up to 30 for NTSC or
25 for PAL), then seconds (up to 59),
then minutes up to 59, then hours up
to 23.
Use |  and | keys to scroll
between values.
Press EXIT to return to the menu
screen.

Control Mode Menu

Select the Control mode. The
highlighted mode is the current mode
after exit.
Press EXIT to return to the menu
screen.

Control Mode has the following functions:

LOCAL
REMOTE
AV/C
SYNCRO SLAVE

Local
Select these options to control the FS-2/2E from the
front panel buttons only. You can also control the
FS-2/2E with the optional wired remote control unit
(ACSS-0019-01). This can be purchased at the
Focus Enhancements online store: https://
www.focusinfo.com/sales/store/.

This sub-menu contains the following selections:

Normal Mode - This is the default
setting. In this mode, recordings are
captured to a single base file until
STOP is triggered, or the nine minute
file size limit is reached.
Index at TC - In this mode, recordings
are continuous until a break in the
incoming timecode stream is detected.
At that time, a new file is automatically
created. No frames are lost during the
transition to a new clip.
Index at Scene - In this mode,
recordings are continuous until a
scene break is detected in the
incoming video stream. At that time, a
new file is automatically created within
one second of the scene change. No
frames are lost during the transition to
a new clip.

NOTE: The Index at Scene option watches the DV
stream for an index marker that is recorded to tape
when a new scene, or record session starts. It
depends upon the camcorder when this index is
recorded to tape. Some camcorders record the
index at every scene, or when the camera is placed
in and out of record pause. Other cameras, only
record the index marker at the beginning of every
record session; in other words, the camera needs to
be placed into STOP or powered-off between
indices. Refer to your camcorder's manual for more
information.

Remote
Select this function to control the FS-2/2E by an
external device through the RS-422 port. The 
FS-2/2E takes on the characteristics of a VTR as
setup in the RS422 MENU screen in the SETUP
MENU. You cannot use the FS-2/2E front panel
controls in this mode.

TIME LAPSE
00:00:00:00:
|  & |
MOVES CURSOR

EXIT

LOCAL
REMOTE
AV/C
SYNCRO SLAVE

EXIT SEL
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The FS-2/2E has a menu item that allows the 
FS-2/2E to appear to external controllers as a Sony
BVW-75 BetaSP VTR when in Remote RS422
mode. It also has a generic RS422 mode.

In remote, you can also slave an FS-2/2E to another
device (such as a Betacam or other non-DV deck)
using the RS422 port.

NOTE: Not all controllable functions of a BVW-75
are available on the FS-2/2E. This mode is only for
greater compatibility with existing control systems.
(Refer to “Supported RS422 Commands” on
page 4-3 for a listing of RS422 supported
commands.

AV/C
Use these settings in PLAYBACK and other
situations where the FS-2/2E is controlled by an
external FireWire device (such as a DV NLE
system).

There three options in this sub-menu: 

Normal Mode - This is the default
setting. In this mode, recordings are

captured to a single base file until
STOP is triggered, or the nine minute
file size limit is reached.
Index at TC - In this mode, recordings
are continuous until a break in the
incoming timecode stream is detected.
At that time, a new file is automatically
created. No frames are lost during the
transition to a new clip.
Index at Scene - In this mode,
recordings are continuous until a
scene break is detected in the
incoming video stream. At that time, a
new file is automatically created within
one second of the scene change. No
frames are lost during the transition to
a new clip. Refer to the note under
Local mode regarding index markers.

NOTE: AV/C does not function completely with all
NLE systems. Contact Focus Enhancements
technical support for more information.
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Syncro Slave
The FS-2E and the FS-2 (with the 2.0 upgrade), has
two settings in Syncro Slave:

NEW FILE - When using this setting
(the default), and the FS-2E is
triggered to stop recording from the
camcorder, the current file is closed
and a new file is opened ready for the
next recording. 
SAME FILE - This option appends the
new recording onto the same file. This
significantly cuts down on the number
of files created and is ideal for many
applications.

In SYNCRO SLAVE mode, a camcorder and the
FS-2/2E share the same record function and the
FS-2/2E is slaved to the camcorder. Once it is set
and you exit the CONTROL MENU, they return to
the default menu screen. The FS-2/2E also
immediately enters REC PAUSE mode and a “Y”
appears next to the record symbol on the FS-2/2E
interface. 

All recording is controlled by the camcorder
exclusively. Every time you press the camcorder’s
REC button, the FS-2/2E goes into the selected
RECORD MODE. Each time you start recording on
your camcorder, a new track is created on disk.

When used with RETRO DISK or RETRO CACHE
functions, as soon as SYNCRO SLAVE is set, the
camcorder begins filling up the selected retro
record buffer. Press the REC button on the
camcorder and the contents of the retro buffer are
appended to the start of your clip. 

The FS-2/2E buttons (other than MENU) are locked
out when in this mode. It is also not possible to use
the optional FS-2/2E remote control units. You must
exit SYNCRO SLAVE by entering the CONTROL
MENU by pressing the MENU button when on the
FS-2/2E main menu. If the camcorder is set to VTR
mode, the FS-2/2E’s control panel becomes active
in order to allow playback. 

If a tape ends while using SYNCRO SLAVE mode,
the FS-2/2E continues to record.

At this point, to STOP a recording, push the FS-2/
2E STOP button twice.

Play Mode Menu

Select the mode. The highlighted
mode is the current mode after exit.
Press EXIT to return to the menu
screen. The default mode is PLAY
CLIP.

Play Clip
For this function, the FS-2/2E plays the selected clip
from start to finish when you press the PLAY button.
At the end of the selected clip, the FS-2/2E pauses.

Loop Clip
For this function, the FS-2/2E plays the selected clip
from start to finish. Immediately after completing the
clip, the FS-2/2E begins playing the clip again
without a pause. It plays this clip until stopped.

Loop All
For this function, the FS-2/2E plays the entire
contents of the disk (all clips) in order from start to
finish. At the end of the last clip, the FS-2/2E begins
to play from the beginning of the first clip again
without a pause. It plays these clips until stopped.

Play All
For this function, the FS-2/2E plays the entire
contents of the disk (all clips) in order from start to
finish. At the end of the last clip, the FS-2/2E
pauses.

PLAY CLIP
LOOP CLIP
LOOP ALL
PLAY ALL

EXIT
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Play From Mode Menu
This selection allows you to select the playback list
used in play mode. There are three options
available.

Select the mode. The highlighted
mode is the current mode after exit.
Press SEL for the highlighted menu
item to open the sub-menu. When you
exit the menu, the last menu item is
the current mode.
Scroll from value to value using the
FORWARD and BACK INDEX
buttons.
Press and  to scroll through digits
in the value. 
Press EXIT to return to the menu
screen. 

Track List
When you select this setting, all clips on attached
disk drives are played back sequentially based on
the order of their base file name regardless of
whether they have been marked in the KEEPER or
SCENE MARKING folders. If Track List is selected,
all PLAY MODES relate to all clips on the
connected disk drives.

Play List
This selection plays the items in the current playlist.

Folder List
When you select this setting, you can play back
clips only from a selected folder. The highlighted
folder is the selected folder after exit. When you
select Folder, all PLAY MODES relate to clips in the
selected folder only.

When the FS-2/2E PLAY MENU is set to
“TRACKLIST” the name of the current folder
appears without brackets on the LCD display (for
example, 2 SCENE 2). 

When the PLAY FROM menu is set to “FOLDERS”,
the name of the current folder appears in brackets
on the LCD display (for example, 2 <SCENE 2>).

Playlist Menu
The FS-2/2E playlist feature allows you to playback
clips in a custom, user-defined order. 

Playlists are created using the FS-2/2E front panel.
You can mark in and out play points on clips.
Multiple playlists can be opened, saved and edited
at any time. Use the PLAY FROM menu to select
the playlist to playback. Use the PLAYLIST menu
selection to modify, open or save playlists.

Playlists can be named with an 8 character/number
name (such as 04-05-04 or PROMO2). 

A playlist can consist of multiple sequences with
whole or portions of recorded clips. Each sequence
gets a number in the playlist starting with 001. The
corresponding track number of the clip sequence is
also displayed (for example, 1-005 is a sequence
from track five on volume 1).

The PLAYLIST menu appears as follows: 

Select the mode from the list. 

Press SEL when highlighting a menu
item to open the sub-menu. When you
exit the menu, the last menu item is
the current mode.
Press EXIT to return to the menu
screen. These settings are saved on
power down.

TRACK LIST
PLAY LIST
FOLDER LIST

EXIT

OPEN
SAVE
NEW
EDIT

EXIT SEL
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Open
Open allows you to open a playlist on disk. Do this
as follows:

STEP 1: In the PLAYLIST menu, select the
OPEN option. A display similar to the
following appears.

STEP 2: Once the sub menu is opened, select
the desired playlist from the list. A
screen similar to the following appears.

STEP 3: Once selected, you can VIEW or PLAY
the playlist. 

If you select the PLAY option, exit to
the main display and press play. The
PLAYLIST button lights and playback
will be from the selected Playlist only. 
You can also play from a playlist using
the PLAY FROM -> PLAYLIST menu. 

Only one playlist can be opened at a time.

NOTE: If you open a playlist without saving
changes to a playlist using the SAVE menu option,
the changes are lost.

Save
When a playlist has been created or modified, use
the SAVE option to write it to disk. 

If you modify a playlist, upon exiting, the SAVE
function automatically appears. 

If you have made modifications and wish to save
them as a new playlist, modify the file name prior to
saving it.

Select NEXT and a display similar to the following
appears.

Select YES or NO.

New
Even if a playlist is open, you can begin creating a
new one. If you create a new playlist without saving
changes using the SAVE menu option, the changes
are lost.

Edit
The edit menu allows you to modify an existing
playlist. 

The selected playlist must be opened in order to
edit. EDIT allows you to remove, insert or move
clips within a playlist. 

To remove a clip, use the following steps:

STEP 1: Select EDIT from the PLAYLIST menu
and then REMOVE CLIP. You are
given a list of clips in the open playlist.
(If no clips are in the playlist, the
message “PLAYLIST EMPTY”
appears.) 

03-20-20
06-20-20
03-25-20
03-30-20

EXIT SEL

PLAY LIST
OPENED

03-20-20

EXIT VIEW PLAY

SAVE PLAYLIST?
02-20-20

NEXT

CONTINUE SAVE?
02-20-20

BACK YES NO
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STEP 2: Select the clip you wish to remove and
then press NEXT.

You will be asked again if you are sure you want to
delete the item from the playlist. 

The INSERT CLIP option allows you to insert a clip
in an existing playlist. A playlist must be opened and
you must have marked in and out points for the clip
you would like to insert before continuing. 

STEP 1: From the PLAYLIST menu, select EDIT
-> INSERT CLIP. The selected clip
number and its details will be listed. 

STEP 2: Press NEXT. 

STEP 3: Select between inserting at the BEGIN,
END or CUSTOM (user-specified) part
of playlist. Once you have selected
your choice, the updated playlist is
displayed. 

The MOVE CLIP option allows you to move a clip
within an existing playlist. To move a clip, use the
following steps:

STEP 1: Select MOVE CLIP from the PLAYLIST
-> EDIT menu. 

STEP 2: Once selected, scroll to the clip you
wish to move. 

STEP 3: Press NEXT. The clip information
displays. 

STEP 4: Select NEXT. You can move the clip to
the BEGIN, END or CUSTOM (user-
specified) part of the playlist. 

STEP 5: Press NEXT. The updated playlist is
displayed.

View 
The VIEW option allows you to view the track
information of an OPEN playlist. A playlist must be
opened in order to view. 

STEP 1: Select VIEW from the PLAYLIST ->
EDIT menu. 

0001 1-001
0002 1-004
0003 1-001
0004 1-003

NEXT

 DELETE ITEM? 
HDD: 01
CLIP 0001
00:00:01:23
00:00:02:00

EXIT YES NO

INSERT ITEM 
 IN CLIP 1-001 
 OUT CLIP 1-001 
 I       00:00:15:00 
O       00:00:21:24 

EXIT NEXT

0001 1-001
0002 1-004
0003 1-001
0004 1-003

NEXT

 CLIP INFO
HDD: 01
CLIP 0001
00:00:01:23
00:00:02:00

EXIT NEXT BACK
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STEP 2: Scroll to the desired clip, then select
NEXT. The clip information is
displayed.

Delete List 
The DELETE LIST option allows you to delete an
entire playlist. 

STEP 1: Select DELETE LIST from the
PLAYLIST menu. All the playlists on
disk are displayed. 

STEP 2: Select the playlist you wish to delete
and press SEL. You are asked to
confirm the request: “DELETE
PLAYLIST XX-XX-XX? “

STEP 3: Press YES to complete the deletion.

HDD Bypass
HDD Bypass mode allows the connected FireWire
hard drives to be mounted or dismounted to a
computer without removing them.

In this mode, the computer connects to the “HDD 
I/O” port on the FS-2/2E Rear Connector Panel.

When you select HDD Bypass, the following
displays on the FS-2/2E LCD:

To Exit this mode, press the EXIT key.
Be sure to properly dismount the
FireWire drive from the computer
system before exiting HDD Bypass
mode on the FS-2/2E.

Internal HDD
The internal HDD function allows you to remove the
front mounted IDE drive from FS-2/2E without first
having to power the unit down. 

Select INTERNAL HDD by pressing
the SEL button.
Answer YES to “Remove Internal
HDD?” (Select EXIT to abort.) 
Remove the disk drive from the 
FS-2/2E when prompted. To remove
the hard drive, push the latch on the
front right of the drive to the right. The
drive handle pops out from the face of
the drive. Then carefully pull the drive
out from the drive bay. Press EXIT to
complete the process.
To reinsert the drive, slide it back into
the drive bay and press the handle
back into place until you hear a click.
The drive will be recognized by the FS-
2/2E after about a minute.

0001 1-001
0002 1-004
0003 1-001
0004 1-003

NEXT

 CLIP INFO
HDD: 01
CLIP 0001
00:00:01:23
00:00:02:00

EXIT BACK

03-20-20
06-20-20
03-25-20
03-30-20

EXIT SEL

GO TO HDD
BYPASS?

EXIT YES NO
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Record Format Menu
The RECORD FORMAT menu allows selection of
particular DTE Technology native NLE file formats
prior to recording. All files are in the DV25 standard.

* These formats are only available for the FS-2E, or the FS-2 with the 2.0
firmware upgrade.

Select a format to activate it. The
highlighted format is the current format
after exit.
Use  to scroll through the selections.
Press EXIT to return to the menu
screen.

NOTE: When recording in AVID OMF or
PINNACLE AVI format, you must first do an
Organize PINN or Organize OMF before using clips
in an NLE. Refer to “Utilities Menu” on page 2-29 for
more details.

Setup Menu
The SETUP menu allows you to set various
functions of the FS-2/2E. 

Select the Menu Item.
Press SEL to open the sub menu
(where applicable).

Use  to scroll through the selections.
Press EXIT to return to the menu
screen.

The SETUP menu contains the following
selections:

SET DATE&TIME
OS VERSION #
OS UPGRADE
PAL/NTSC
RS422 REMOTE
AUDIO IN LEVELS
TC MODE
TC SET
ON SCREEN DIS
FF/RW HI RES
GPI PORT
BACKLIGHT
STOP OUTPUT
AUDIO CORRECT
PREFERENCES
FOLDER PREF
ANALOG OUT
NETWORK SETUP
REF VIDEO
VIDEO OUT ADJ
COMPNT LEVEL

Set Date & Time
This selection provides a way to set date and time
for file naming purposes. Date and Time are set in
different menus.

Select the Menu Item. 

RAW DV
AVI TYPE 1
AVI TYPE 2
CANOPUS AVI
MATROX AVI
QUICKTIME
AVID OMF
PINNACLE
24P AVI TYPE 2*
24P QUICKTIME*
EXIT

SET DATE&TIME
OS VERSION #
OS UPGRADE
PAL/NTSC

EXIT SEL

SET DATE
SET TIME

EXIT SEL
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Press SEL to open one of the following
sub menus.

Move from field to field using the
FORWARD and BACK INDEX
Buttons.
Press  and  to scroll through digits
in the value. 
Press EXIT to return to the menu
screen. Regardless of the display, the
file name always remains as follows:
YYYYMMDD-HHMMSS.xxx 
(Year-Month-Date-Hour-Minute-
Second).

The date and time form the basis of the FS-2/2E file
naming structure for use of clips on a computer.

On the FS-2/2E, files are identified by TRACK and
VOLUME (disk drive) number on the LCD. For
instance, a file on the FS-2/2E LCD identified as 1-
043 is clip number 43 on Volume (disk) 1.

On a computer, files are identified by their base file
name made up of DATE and TIME. For instance, a
clip named 20050615-210943-01.mov is a clip that
began recording at 9:09:43PM on June 15th. 2005.

NOTE: DATE/TIME is used when creating file
names only. The FS-2/2E does not record this
information into the stream. The FS-2/2E records
the date and time which is in the DV stream sent
from the input source.

OS Version #

This selection displays the current FS-2/2E
Operating System (OS) Firmware version.

OS Upgrade
To upgrade operating system (OS) software, you
must download a new .bin file to a FireWire drive on
your computer. The latest version of FS-2/2E
software can be downloaded from http://
www.focusinfo.com/support.

To install new OS software to the FS-2/2E, do the
following:

STEP 1: Download software from the Focus
Website to your local computer.

STEP 2: Unzip file using WinZip (Windows) or
Stuffit (Macintosh) on a computer
system with a FireWire (IEEE-1394)
connection.

STEP 3: Rename the unzipped file called
“XXXX.bin” to “fs2.bin”.

STEP 4: Connect a FireWire disk drive that has
been used with the FS-2/2E to the
computer and copy over the file
“fs2.bin”.

STEP 5: Disconnect the FireWire drive from
computer and connect it to the 
FS-2/2E.

STEP 6: Unless you are using the internal the
FS-2/2E hard disk drive to upgrade
your unit, remove your internal hard
drive before powering on your FS-2/2E.

STEP 7: If you are using an external FireWire
drive attach it to the FS-2/2E 1394 port
labelled “To HDD”.

STEP 8: Power on FS-2/2E normally.

STEP 9: Enter the FS-2/2E menu and select
“SETUP”.

STEP 10: From the SETUP menu, select “OS
UPGRADE”. The following screen

SYSTEM DATE
02/24/02
|  & | 
MOVES CURSOR

EXIT

SYSTEM TIME
16:21:13
|  & | 
MOVES CURSOR

EXIT

OS VERSION
3.0.m.032603

EXIT
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appears:

STEP 11: Select YES. You are warned with the
following display:

STEP 12: Select YES to begin the OS upgrade.

A message appears indicating the upgrade has
begun.

STEP 13: After upgrade is complete, power cycle
the FS-2/2E. The new software should
now be loaded and ready to use.

If no .bin file is found, the screen displays “OS
UPGRADE ERROR”. Check your connections and
make sure you have the correct file name. 

You must restart your system once an OS upgrade
is complete.

NOTE: If you need to restore the factory default
Operating System, hold down the Left and Middle
soft keys under the LCD during boot up.

PAL/NTSC
Use this screen to select the record standard as
either PAL or NTSC. The highlighted selection is
the current one after exit. The FS-2/2E uses this
video standard for both playback and record.

NOTE: Do not combine PAL and NTSC clips on a
single drive.

RS422 Remote
This submenu allows you to setup the FS-2/2E for
remote operation using the RS422 control port. 

For easy integration with existing control systems,
you can make the FS-2/2E look like either a Sony
BVW-75 Betacam SP deck or a generic recorder.
Using the TC SOURCE submenu, you can also
select the timecode source for FS-2/2E control.
Options are ABS, DV and COUNTER.

You can set the FS-2/2E to two different remote
modes:

BVW-75 – The FS-2/2E appears as
and is identified as a Sony BVW-75
BetaSP deck to the remote control
device.
NOTE: Some BVW-75 control func-
tions are not available on the FS-2/2E.
The FS-2/2E mainly responds to com-
mands such as PLAY, STOP,
REWIND, REC, FF, and so on. Com-
mands such as Insert, Edit, and other
specialty commands are not possible.
Refer to “Supported RS422 Com-
mands” on page 4-3 for more informa-
tion on supported commands.
Generic - The FS-2/2E appears as and
is identified as a generic device to the
remote controller.

UPGRADE
SYSTEM
FIRMWARE

EXIT YES NO

UPGRADE WILL
ERASE CURRENT
OS!!!
CONTINUE?

EXIT YES NO

NTSC
PAL

EXIT

TYPE
TC SOURCE

EXIT
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After you have set up RS422 to control the FS-2/2E
using an external RS422 device, press the
REMOTE button on the front panel or select
REMOTE from the Control Mode menu.

Audio Input
In this submenu, you can change the default audio
input linked to a particular video input. 

Select the mode to activate it. 

Press SEL for the highlighted menu
item to open the sub-menu. In the sub-
menu, the currently highlighted mode
is the current mode after exit.
Press EXIT to return to the menu
screen. These settings are saved on
power down.

Each video input and its available audio inputs
(defaults are underlined) are listed below:

Composite: Analog Balanced Audio
AES/EBU Digital Audio
S-Video (Y/C): Analog Balanced Audio
AES/EBU Digital Audio
Component: Analog Balanced Audio
AES/EBU Digital Audio
SDI: Embedded
Analog Balanced Audio
AES/EBU Digital Audio
DV: Embedded

NOTE: The FS-2E provides the option to select
channels 1 and 2 or 3 and 4 of the embedded audio
of the SDI input stream. This is an FS-2E feature
only.
There is a SETUP->AUDIO INPUT->SDI-
>EMBEDDED submenu that provides the following
options:

CHAN 1&2
CHAN 3&4

Audio In Levels
This menu item allows you to set the audio input
levels for FS-2/2E. 

Adjust the audio level between -34.5dB and +4.5dB
in 1.5dB increments.

TC Mode
This submenu allows you to select different
timecode options for use when the FS-2/2E is
recording. 

Select the mode. 

Press SEL to open the sub-menu.
When you exit the menu, the
highlighted menu item is the current
mode.
Press EXIT to return to the menu
screen. These settings are saved on
power down.

This submenu contains the following selections:

EXT TC Mode - Whatever the
incoming timecode, the FS-2/2E
records it. You can select between
SELECTED INPUT, VITC
REFERENCE, VITC ANALOG, LTC,
EMBEDDED DV, and EMBEDDED
SDI. Select the desired TC source.
Choosing EXT TC mode will clear any
stored timecode value.

COMPOSITE
S-VIDEO
COMPONENT
SDI

EXIT SEL

0.0dB

|----------------------------------x----------------------|

EXIT

EXT TC
REC RUN
REGEN
FREE RUN

EXIT SEL
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NOTE: If the FS-2/2E is set to EXT TC
when in SYNCRO SLAVE mode, EXT
TC stops once the tape in the cam-
corder ends. Focus Enhancements
suggests that you use a different TC
mode when using SYNCRO SLAVE.
NOTE: TC Preset cannot be changed
while in the EXT TC mode.
REC RUN Mode - In this mode, the
FS-2/2E does the following:

(1) Uses the last timecode number 
recorded + 1 as the timecode 
number for the first frame of the 
next recording.

(2) Uses the number entered by a 
setting in the TC PRESET menu 
for the first frame of the next 
recording.

The last number used is stored in 
the memory, so this mode persists 
across recording sessions.

REGEN Mode - After a disk is
mounted (at startup, upon manual
connect) and after the track list has
been constructed, the FS-2/2E looks
at the last track and looks at the
timecode number of the last frame in
that track. The FS-2/2E stores that
number for use as the TC value (+ 1)
for the first frame of the next recording.
If the drive is empty, the FS-2/2E uses
the TC PRESET(+ 1).
FREE RUN Mode - When you enable
FREE RUN mode, the FS-2/2E begins
counting from the value stored. If you
uses the TC PRESET function, when
the number is entered and the TC
PRESET menu is exited, the FS-2/2E
begins counting from that value.

Once a timecode value is set and the FS-2/2E is set
to REC RUN or FREE RUN timecode settings, the
TC preset value becomes the starting point for
timecode. 

TC Set
This menu allows you to set Timecode values for
various modes. It also allows the selection of drop
or non-drop frame (NTSC only) settings.

NOTE: The FS-2E, or FS-2 (with the 2.0 upgrade),
has the added ability to delay the recorded
timecode relative to the content.

Once a timecode value is set and the FS-2/2E is set
to REC RUN or FREE RUN timecode settings, the
TC preset value becomes the starting point for
timecode. Use this menu as follows:

Display this menu item by selecting it. 
Press SEL to open the sub menu of
choice. 
Press EXIT to return to the menu
screen.

For TC PRESET, scroll from field to
field using the FORWARD and BACK
INDEX Buttons. 
Press  and  to scroll through digits
in the value. 
Press EXIT to return to the menu
screen.

This selection allows you to set the starting
timecode value for future recordings. 

For UB Preset, scroll from field to field
using the FORWARD and BACK
INDEX Buttons. 
Press  and  to scroll through the
hex digits in the value. 

TC PRESET
UB PRESET
DROP/NON DROP

EXIT SEL

TC PRESET
2:00:00:00:00

|  & |
MOVES CURSOR

EXIT
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Press EXIT to return to the menu
screen.

NOTE: You cannot set UB values after selecting
EXT TC mode in the TC MODE menu.

For DROP and NON-DROP, select the
mode. The highlighted mode is the
current mode after exit. 
Press EXIT to return to the menu
screen.

This selection is not applicable for PAL use. On the
FS-2/2E display, DROP is identified by a semicolon
(;) and NON-DROP by a colon (:).

TC Delay (FS-2E only)
The TC DELAY menu is only available for the 
FS-2E, or FS-2 (with the 2.0 upgrade). This menu
allows you to delay the recorded timecode up to 29
frames.

TC DELAY: 00

Use  (middle soft key) and  (right soft key) to
adjust the delay value. Press EXIT when done.

On Screen Display

This selection allows you to turn on or off the on-
screen display on FS-2/2E's Monitor Output. The
highlighted item is saved after exit.

When you select ABS, the absolute timecode value,
or amount of time recorded to the disk, appears on
the bottom center of the monitor output.

When you select TC, the TC (Counter) timecode
value appears on the bottom center of the monitor
output.

When you select MENU, the FS-2/2E Menu
appears in the top left corner of the monitor output.

Press  and  to scroll though the
selections. 
Press EXIT to return to the menu
screen.

NOTE: By repeatedly pressing the front panel OSD
key, you can cycle between these modes.

FF/RW Hi Res

This screen enables or disables the FS-2/2E
forward and reverse search high resolution mode.
When enabled the following search speeds are
available:

REVERSE: -30X, -25X, -18X, -15X, -
12X, -10X, -8X, -5X, -4X, -3X, -2X, 
-1/30, -1/15, -1/10, -1/6, -1/5, -1/3,-1/2
FORWARD: +30X, +25X, +18X, +15X,
+12X, +10X, +8X, +5X, +4X, +3X,
+2X, +1/30, +1/15, +1/10, +1/6, +1/5,
+1/3, +1/2

The highlighted mode is the current
mode after exit.
Press EXIT to return to the menu
screen.

UB PRESET
F:00:00:00:00

|  & |
MOVES CURSOR

EXIT

DROP
NON-DROP

EXIT

ABS
TC
MENU
OFF

EXIT
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GPI Port
This menu allows you to change the setting of the
GPI port. 

The highlighted function is the current
setting after exit. 
Press EXIT to return to the menu
screen.

DISABLE - This selection allows you
to connect a 3.5mm to DB9 cable to
the GPI port and control the FS-2/2E
using RS232C from an external
device. You can also use the FS-2/2E
with the optional wired remote control
unit (ACSS-0019-01). Purchase this
item at the Focus Enhancements
online store: https://
www.focusinfo.com/sales/store/.

The remaining three selections allow functions to
occur from a simple contact closure as follows:.

PAUSE/UNPAUSE -This selection
allows control of pause and unpause
during a record or playback session.
INDEX (NEW FILE) - This setting
creates a new file during a record
session without losing any frames.
REC SNAPSHOT - This setting
records a single frame of video to a

file. Each sequential use of this
function captures another frame to the
same file until stopped.

Backlight
This selection enables or disables the FS-2/2E LCD
backlight. 

The highlighted state is saved after
exit. 
Press EXIT to return to the menu
screen.

The ON setting leaves the LCD backlight on
continuously. The OFF setting turns it off.

AUTO OFF turns off the backlight after one minute.
Press any keypad button on the FS-2/2E to turn the
LCD backlight back.

Stop Output
Use this option to select the video displayed while
the FS-2/2E is in STOP mode. The selected mode
is the current state after exit.

NOTE: This setting does not effect E-E mode.

When you select GRAY, a black screen appears. 

If you select NO OUTPUT, a blank screen appears. 

If you select CLIP PREVIEW. The first frame of
each clip is generated and shows on all outputs
after 1 second if you pause on that clip. 

ENABLE
DISABLE

EXIT

DISABLE
PAUSE/UNPAUSE
INDEX (NEW FILE)
REC SNAPSHOT

EXIT

BACKLIGHT
ON
OFF
AUTO OFF

EXIT

GRAY
NO OUTPUT
CLIP PREVIEW
CUSTOM

EXIT
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If you select CUSTOM, the FS-2/2E looks on disk
drive volume 1 for any clip named “SPLASH.dv”
and always displays the first frame of that clip. You
can name any RawDV clip “Splash.dv” and the first
frame from that clip appears as the default output in
STOP mode. 

Audio Correct
This sub-menu allows you to change the AUDIO
CORRECTION setting on the FS-2/2E.

The highlighted state is saved after
exiting.
Press EXIT to return to the menu
screen.

The AUDIO CORRECTION selection is an
advanced feature of the FS-2/2E. You should use
the factory default settings for most operations
(Factory default is MEDIUM). 

Audio Correction Mode allows you to alter the
performance of the audio error corrector while
recording. It is useful when recording to the FS-2/2E
from tapes containing dropouts. Error correction
only effects AVI 2, Canopus AVI, Matrox AVI,
QuickTime, AVID OMF, Pinnacle, 24p QuickTime,
and 24p AVI Type 2. It does not effect RawDV or
AVI 1. The selections are:

OFF: No audio correction.
MEDIUM (default): “Normal” clean
tapes played back on a camcorder or
other VTR with clean heads. When
error correction occurs, the audio can
be muted for brief periods of time.
HIGH: For cases where there are
visible picture disturbances and likely
long audio dropouts (1/2 sec and up).

Preferences
This menu allows you to save and restore system
preferences. 

When you select ‘SAVE”, you are prompted with the
message “SAVE CURRENT PREFERENCES?”.
Press YES and a file is written to the disk drive
saving the current user settings.

When you select RESTORE the FS-2/2E searches
for a saved user preference on the disk and if found,
restores your PREFERENCES. PREFERENCES
are a snapshot of all settings that can be saved on
the FS-2/2E.

Folder Pref
The FOLDER PREF menu allows you to determine
the folders to which your clips are moved when you
choose to do a ORGANIZE CLIPS from the
UTILITIES menu. This menu contains the following
sections:

SCENE MARK - (default setting) only
marks those clips you explicitly mark
during record or playback.
AUTO MARK - marks all recorded
clips with the last selected FOLDER.

NOTE: These features are most easily used in
conjunction with the optional wired remote control.
This can be ordered at the Focus Enhancements
on-line store: https://www.focusinfo.com/sales/
store/. The part number is ACSS-0019-01.

Analog Out
This screen provides to selections: Composite or
Component

When you select the composite output,
the “Y” output on the rear panel
provides a composite signal.
When you select component out, you
can also select either SMPTE,

AUDIO CORRECT
OFF
MEDIUM
HIGH

EXIT

PREFERENCES
SAVE
RESTORE

EXIT SEL
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BETACAM, or MII output levels. Refer
to Chapter 4 for more information.

The selected mode becomes highlighted after you
select Exit.

Network Setup
With NETWORK SETUP, you can connect the 
FS-2/2E to a network. When this is done, you can
do FTP file transfers to or from the FS-2/2E or
control the FS-2/2E using Telnet. The FS-2E, or 
FS-2, with the 2.0 software upgrade also allows you
to control using your internet browser. The
NETWORK SETTINGS MENU contains the
following:

IP SETTINGS 
USER/PASSWORD 
VIEW IP INFO 
SERVICES 

FOCUS Enhancements is in no way liable for
device security (Telnet and FTP). Contact your
system administrator regarding the best security
practices.

IP SETTINGS 

With the IP settings menu item, you can select
either DHCP (the network provides the IP address)
or a CUSTOM IP. 

If you select DHCP and then EXIT, the FS-2/2E
attempts to log onto the network. 

If you select CUSTOM IP, a submenu opens to ask
you to enter an IP number, Sub Net Mask, and
Gateway. 

If you do not have these values, contact your
system administrator. The default values for the IP
address is 000.000.000.000, Sub Net Mask
255.255.255.000 and Gateway 000.000.000.000.

To modify the custom IP values use the following
steps:

STEP 1: Select the item to modify.

STEP 2: Press  to select the field to change. 

STEP 3: Use the  to increase the value (HINT:
press the SHIFT key on the FS-2/2E
front panel plus  to decrease a
value). 

Values wrap back to zero once the
maximum value has been entered. 

STEP 4: To modify the next item or set of
values, press the NEXT key on the 
FS-2/2E front panel.

STEP 5: Once complete, press the SEL key
when EXIT is highlighted to exit or the
NEXT key to continue to modify items. 

Once you exit the menu, the FS-2/2E attempts to
log into the network and one of two things happen:

If the FS-2/2E successfully logs onto a
network, it displays NETWORK
CONNECT SUCCEEDED. 
If the FS-2/2E is unable to log onto a
network, it displays “NET CONNECT
FAILED. CHECK NETWORK CABLE”. 

Press the VERIFY button on the FS-2/2E to take
you back to the IP Settings menu to verify your
values.

DHCP
CUSTOM IP

EXIT SEL

IP ADDRESS 000.000.000.000
SUBNET MASK 255.255.255.255
GWY 000.000.000.000

EXIT

NEXT SEL
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Press the EXIT button to take you back to the
SETUP menu.

USER/PASSWORD 

This screen allows you to set a username and
password for the FS-2/2E. If you are unsure what
username and password to use, contact your
system administrator. 

To modify the username and password, use the
following steps:

STEP 1: Select the item to modify and then
press the right arrow key to select the
field. 

STEP 2: Use  to increase the value (HINT:
press the SHIFT key on the FS-2/2E
front panel plus  to decrease a
value). 

Values loop back to zero once the
maximum value has been entered. 

STEP 3: To modify the next item, press the
NEXT key on the FS-2/2E front panel.
It is only possible to have one
username and password per unit. The
maximum number of characters for
each is seven.

VIEW IP INFO 

In cases where DHCP is being used, by selecting
VIEW IP INFO, you can see the IP address that the
network has provided the FS-2/2E. 

If the FS-2/2E is not connected to a network or was
not able to successfully log on, this screen displays
“DHCP DISABLED NOT CONNECTED”. Check
your settings or contact your system administrator
for further assistance.

SERVICES 

The SERVICES menu allows you to enable or
disable any of these services: FTP, TELNET, or
WEB connection. With each, it is necessary to
enable or disable the function within the submenu.

Once FTP is enabled you can use your web
browser or ftp utility to transfer file to and from the
FS-2/2E.

With TELNET enabled, you can send commands to
control the FS-2/2E with a telnet utility.

With WEB enabled, you can control the FS-2/2E
from your web browser. Type in the FS-2/2E IP
address into the address bar of your browser to
start using the web interface. Only an FS-2E or FS-
2 (with the 2.0 firmware upgrade) has this option
available.

Use the web interface to control, change settings,
edit playlists, and even delete tracks on the 
FS-2/2E.

USER: FS2
PASWD: FOCUS
EXIT
SAVE

NEXT

IP 100.000
001.000

MSK 255.000
000.000

DHCP DISABLED
NOT CONNECTED
NEXT

FTP
TELNET
WEB

EXIT SEL
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An example of the web interface is shown below.

Ref Video
The Reference video menu allows you to select
where the reference video source will come from for
playback and whether the video out will be locked to
the reference video input in playback modes,
Choices are:

REF VIDEO - the reference video port
on FS-2/2E's rear panel,
FREE RUN - reference video is
generated on the FS-2/2E.

NOTE: If the loop-through jack is not connected,
make sure the output is terminated using an
external 75 ohm terminator.

Video Out Adj
The VIDEO OUT ADJ menu options allow you to
make adjustments to FS-2/2E analog output
sources. 

HUE - adjustable between -179 and
+180
SATURATION- adjustable between -
255 and +256
BRIGHTNESS- adjustable between -
127 and +128
CONTRAST- adjustable between -127
and +128
BLACK LEVEL - Allows the output
black level to be set to either 0 IRE or
7.5 IRE. 0 IRE is the default setting.
This menu item is only present when
the FS-2/2E is set to NTSC mode. 

SC PHASE - Allows the subcarrier
phase to be adjusted between +127
and -128. The default value is set at 0.
Press and hold either  or  for more
than 3 seconds to change the value by
increments of ten.
H PHASE - Allows the horizontal
phase to be adjusted between +127
and 
-128. The default value is set at 0.
Press and hold either  or  for more
than 3 seconds to change the value by
increments of ten. 

NOTE: The HUE, BLACK LEVEL, and SC PHASE
adjustments are not available when the unit is
configured for component out.

Compnt Level
Note: This is available only in NTSC mode. It is not
available in PAL mode.

For both the component inputs and outputs you can
select from three video signal level standards:

SMPTE
BETA
MII 

Refer to Chapter 4 for more details.

Utilities Menu
This menu allows you to access various utilities. 

Select the Menu Item. Press SEL to
open the sub menu (where
applicable).
Press EXIT to return to the menu
screen.

This menu contains the following selections:

ORGANIZE PINN
ORGANIZE CLIP

ORGANIZE PINN
ORGANIZE OMF
DELETE CLIP

EXIT SEL
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ORGANIZE OMF
DELETE CLIP
FORMAT
PARTITION
REPAIR
FILE NAME
FACTORY RESET
DIAGNOSTIC

Organize PINN
Once you have finished a Pinnacle recording
session, do the following: 

STEP 1: From the FireStore SETUP MENU,
select ORGANIZE PINN. 

STEP 2: When prompted “ORGANIZE
PINNACLE CLIPS? Select YES. 

STEP 3: You can now remove the disk drive
from FireStore to begin editing. 

Products such as the Pinnacle AVI file format were
created for use with products such as Pinnacle
Liquid Edition. The Pinnacle AVI file format creates
three files simultaneously during a recording; an
AVI video file and two separate WAV audio files
labeled as left and right. An additional “Edition.ale”
file per recording session is also created which
contains timecode data. This file must be kept with
the media. This is shown in the following illustration.

Once clips have been imported into Liquid Edition,
an Index file is created on the disk drive per clip. Do
not delete this file since it is required to continue
work in the particular project. The illustration below
shows this.

Organize Clip
This selection places all files that were identified as
a KEEPER or were SCENE MARKED during
recording into a folder marked KEEPER or the
prenamed SCENE MARKING folders on the disk
drive. These folders can be imported directly into
most DV NLE bins.

When you make this selection, the following screen
appears:

Organize OMF
When files are recorded in the AVID OMF file
format, this command automatically takes all the
OMF and AIF audio files at the end of a recording
session and places them into a folder on the disk
drive named “OMFI MediaFiles”. When the disk is
connected to a computer, this folder is recognized
by Avid’s Media Tool feature enabling direct import
of files into the Avid timeline.

NOTE: If you have selected files as a KEEPER or
they have been SCENE MARKED, you cannot use
this feature and keep files in their selected folders.
If you would like to use clips in KEEPER or SCENE
MARKED folders in Avid, manually create the
“OMFI MediaFiles” folder when your disk drive is on
your computer and drag the desired clips into this
folder.

When you make this selection, the following screen
appears:

ORGANIZE
KEEP CLIPS?

EXIT YES NO
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For more information on using FS-2/2E clips in
Avid, refer to “Using FireStore FS-2/2E Recorded
Avid Clips on Avid Editing Systems” on page 3-4.

Delete Clip
When you make this selection, the following screen
appears:

In the DELETE CLIP X-XXX screen,
select between clips by pressing the

 and  buttons. 
If you select YES, a message appears
indicating that the selected clip is
being deleted.
Press EXIT to return to the menu
screen.

Once a clip has been deleted, the FS-2/2E display
re-organizes the clip number sequence. For
instance, if there are three clips on disk (1-001, 1-
002, 1-003) and you delete clip 1-002, after delete
is complete, clip 1-003 becomes clip 1-002. Base
file names are not affected however.

NOTE: It is generally not recommended to delete
too many clips (greater than 30), since
fragmentation may occur.

Format Disk
When you make this selection, the following screen
appears:

Select between volumes by pressing
the  and  buttons. 
When you select the volume and press
YES, the following screen appears:

When you select YES, a message
indicating the formatting appears.
Press EXIT to return to the menu
screen.

Partition
When you make this selection, select the
connected disk drive you wish to partition. The
following screen appears:

ORGANIZE
AVID OMF CLIP?
 

EXIT YES NO

DELETE 
CLIP 1-001? :21:13
 BASE: 
20010612-165423

EXIT YES

FORMAT DISK
VOLUME 1? :
 

EXIT YES NO

FORMAT WILL
ERASE ALL DATA!! :
CONTINUE FORMAT
VOL 1

EXIT YES NO

PARTITION WILL
ERASE ALL DATA!! :
CONTINUE FORMAT
VOL 1

EXIT YES NO
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When an unknown volume type (HDD) is connected
to the FS-2/2E, the Partition process puts a FAT32
format onto the drive. It erases any previous
partition and data.

Select YES and a progress message appears on
the screen.

NOTE: You cannot add multiple partitions an a
single drive using the FS-2/2E.

With drives greater than 128G, the FS-2/2E creates
multiple partitions. There will be a partition for each
128G of disk space available.

Repair
When you make this selection, the following screen
appears:

Select the desired function. 
Press SEL to make a selection. 
Press EXIT to return to the menu
screen.

CHECK DISK 

This selection scans the entire volume for any
errors (usually, if a file was corrupted during a
recording, check disk alerts you of this).

CURRENT CLIP 

This selection performs a similar function, but on
the selected clip only. If an error is found, the 
FS-2/2E prompts you to repair the problem.
CURRENT CLIP repairs the last file in the current
session if it has been damaged.

Select between volumes by pressing the  and
 buttons. Press EXIT to return to the menu

screen.

File Name
When you make this selection, the following screen
appears:

This selection displays the base file name of the
selected clip.

Factory Reset
When you select this function, the FS-2/2E reverts
all settings and values back to its factory default
state.

Press YES to start factory reset. 
Press EXIT or NO to exit from the
menu. 

Warning: Factory Reset is not un-doable!!!

Diagnostic
When you make this selection, a screen similar to
the following appears:

This is a setting used for diagnosing field issues. Do
not change it unless told to by Focus
Enhancements Technical Support.

CHECK DISK
CURRENT CLIP

EXIT SEL

CLIP 1-001
BASE: :
20010612-166523

EXIT

DIAG LVL: 00

EXIT
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CHAPTER 3
USING THE FS-2/2E

This chapter contains the following procedures:

How to Make a Recording
How to Playback

How to Put Recorded Clips on a
Computer System
Creating a Playlist
How to Mark Scenes
Connecting the FS-2/2E to a Network

To perform these procedures use input and output
sources as illustrated in the following diagram.

FS-2/2E REAR PANEL
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How to Make a Recording
Use the following procedure to make a recording
using the FS-2/2E.

STEP 1: Make sure the FS-2/2E is connected to
power and has been turned on using
the power switch on the rear of the
chassis.

STEP 2: Connect the required devices as
explained in Chapter One. For this
example, that would include a video
source (audio and video), speakers or
headset if desired, and a monitor if
desired.

STEP 3: Make sure the drive in the FS-2/2E has
been formatted. If it is not, the LCD
screen indicates that it has not been.
Refer to the “Utilities Menu” on page 2-
29.

STEP 4: Manually select the input source using
the front panel buttons (that is,
CMPST, Y/C, CMPNT, SDI, or DV).

STEP 5: Select the record format as follows:
a. Press the Menu soft key.
b. Select RECORD FORMAT
c. Select the desired format using the 

 soft key to highlight your 
selection.

d. Press EXIT twice.

STEP 6: Press the red record button twice.
(Pressing this button once places the
FS-2/2E in record-pause. Pressing it
again starts the recording.) Timecode
on the front panel LCD advances when
recording begins.

STEP 7: Press STOP when you have finished
the recording.

How to Playback 
Use the following procedure to playback a
recording using the FS-2/2E. 

NOTE: In all cases, if a monitor is connected to the
video output, it displays the signal going through the
FS-2/2E

This procedure assumes that you have already
recorded material on the hard drive as explained in
the previous section.

STEP 1: Select the desired clip by using the

Forward Index and Back Index buttons.
These buttons step you through the
clips on the selected disk drive.

STEP 2: If more than one disk drive is
connected, press the SHIFT and the
Forward Index or Back Index key as
required until the desired drive appears
on the LCD.

STEP 3: Press the PLAY button once to begin
playback.

STEP 4: Press the Stop button once to pause or
twice to stop the playback.

How to Put Recorded Clips 
on a Computer System
Once you have recorded clips to a FireWire disk
drive using FireStore, you can use those clips in
most computer based DV NLE systems. 

Traditionally, in order to get footage into an NLE
system, it was necessary to capture or digitize that
footage utilizing a video capture card. Using the 
FS-2/2E recorded clips, you can skip this capture
stage by just connecting a FireWire disk drive to
your computer using an OHCI compliant IEEE-1394
(FireWire) PCI card or connect direct from the 
FS-2/2E using the HDD Bypass mode (refer to
“HDD Bypass” on page 2-18 for more information).

You can connect FireWire disk drives used with the
FS-2/2E to any computer system that will read a
FAT 32 volume. This includes Windows 98SE,
Windows ME, Windows 2000, Windows XP and
Mac OS9 and OS10.

Check the FOCUS Enhancements' website
(www.FOCUSinfo.com) for more information.

In order to use the FS-2/2E recorded FireWire disk
drives on a computer, you must have an active
IEEE-1394 connection on your computer. You also
must have loaded any required FireWire disk drive
drivers onto your computer system Consult your
FireWire disk drive documentation for more
information. 

Connect your FireWire disk drive to your computer
system utilizing a standard 6-pin to 6-pin FireWire
cable and connect power to the drive if necessary.

Consult the FireWire disk drive documentation for
more information.
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This section contains the following subsections:

Mounting FireWire Disk Drives
(Windows XP, 2000, 98SE and ME)
Using FireStore FS-2/2E Recorded
Avid OMF Clips on Avid Editing
Systems
Dismounting FireWire Disk Drives
(Windows XP, 2000, 98SE and ME)
Mounting FireWire Disk Drives
(Macintosh)
Dismounting FireWire Disk Drives
(Macintosh)

Mounting FireWire Disk Drives 
(Windows XP, 2000, 98SE and ME)
STEP 1: On a Windows-based computer

system, double click the My Computer
icon on the top left hand corner of the
desktop. You will see a window similar
to the following:

STEP 2: Locate your FireWire disk drive. This
will probably be labeled E:, F:, G:, and
so on. (drive C: is usually your
computer's main disk drive). 

STEP 3: Once you have identified it, double
click on the FireWire disk drive. 
Once opened, you should see a win-
dow similar to the following:

The FireWire disk drive can contain several
different files. Clips can appear as 

RawDV (.dv)
AVI Type 1
(YYYYMMDDHHMMSSa01)
AVI Type 2 or 24p AVI Type 2
(YYYYMMDDHHMMSSb01)
Canopus AVI 
(YYYYMMDD-HHMMSSb01)
Matrox AVI 
(YYYYMMDD-HHMMSSm01 with a
separate .wav audio file per track)
Pinnacle AVI
(YYYYMMDD-HHMMSSp01 with two
separate .wav audio files per track)
QuickTime or 24p Quicktime (.mov)
Avid OMF (.omf with two separate .aif
audio files per track).

The FAT32 file system has a limitation such that
any particular file cannot exceed 2GB in size. This
equates to roughly 9 minutes of recording time.

When clips are being recorded to FireStore that
exceed 9 minutes in length, FireStore automatically
creates a new file without dropping any frames. 

The two clips have the same primary file name,
however, the last two digits are different. 

The first 2GB part of the clip is labeled with “-01”
after the primary file name. 
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The second 2GB segment is labeled with a “-02”.
Additional 2GB segments are labeled with a “-XX”
number.

With most NLE systems on a Windows computer, it
is possible to utilize clips within the timeline by
selecting the clips on the source volume (in this
case, the connected FireWire disk drive) and
importing them directly into the NLE’s bin. 

Clips can then be immediately used in the NLE’s
timeline. 

With FireWire disk drives such as the FireStore
FSHDD-1, the drive itself is fast enough to directly
stream the clips to the NLE eliminating the need to
copy or transfer the clips before use.

When utilizing the Avid OMF file format, you must
follow the following steps to import clips.

Using FireStore FS-2/2E 
Recorded Avid OMF Clips on Avid 
Editing Systems
The Avid DV OMF file format was developed for use
with Avid editing systems on Windows 2000,
Windows XP or Mac 0S10. These include Avid
Xpress Pro, NewsCutter, Media Composer
Adrenaline, and Symphony (with the DV option).

The Avid DV OMF file format creates three files
simultaneously; an OMF video file and two separate
AIF audio files. On the computer's desktop, the files
appear as shown in the next illustration.

On the FS-2/2E, the video file (OMF) and the audio
files (AIF) appear as one track. 

If you delete an Avid DV OMF file, the FS-2/2E
deletes the audio and video portions at the same
time.

In order to use the FS-2/2E recorded Avid DV OMF
files on your Avid NLE system from the external
FireWire drive, use the following procedure.

STEP 1: Locate the external FireWire drive on
your computer. 
If you have trouble, you can locate the
name of the external drive by selecting
“My Computer” on a Windows system.
On a Mac, the FireWire drive should
appear on the desktop.

STEP 2: Open the FireWire drive when you
have found it and create a new folder
named “OMFI MediaFiles”. 
To do this on Windows, select File>
New>Folder from the pull down menu. 
On Mac, select File>New Folder. You
must type “OMFI MediaFiles” correctly
in order for Avid to see the disk drive. 

STEP 3: Drag all the OMF and AIF files into the
new folder (do not drag in the files titled
Desktop DB or Desktop DF). 
NOTE: if you are using the ORGA-
NIZE OMF function on the FS-2/2E
prior to using the disk on a computer,
steps 2 and 3 are not necessary.

STEP 4: Launch Avid. 
STEP 5: Once you have opened the desired

project or created a new project, select
Tools>MediaTool. The following
window appears:
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STEP 6: Locate and select the external FireWire
drive under Media Drive(s). 
NOTE: If the drive does not appear,
check to make sure you have created
the OMFI MediaFiles folder correctly
with proper case and spacing. Also,
check to see that the drive is properly
connected and recognized by the com-
puter). Under Project(s), select All
Projects (This highlights all items in the
Project(s) window). 

STEP 7: Ensure Master Clips is checked and
press OK. The following Media Tools
Window appears:

STEP 8: Create a new bin (select File -> New
Bin) or open an existing bin in Avid. 

STEP 9: Once opened, select all items in the
Media Tools window (select Edit>
Select All). 

STEP 10: Drag the contents of the Media Tools
Window into the bin. You can nos use
these clips in the Avid timeline.

Dismounting FireWire Disk Drives 
(Windows XP, 2000, 98SE and ME)
Once you have completed working with your disk
drive on a Windows XP, Windows 2000, Windows
98SE or Windows ME computer system, you must
dismount the drive before unplugging it. 

To do this, use the following procedure: 

STEP 1: Click the Safely Remove Hardware
icon at the bottom right side of the
Windows task bar as shown below.

STEP 2: The computer system prompts you to
“remove” the connected FireWire disk
drive. This begins the dismount
process. 

STEP 3: Select the message by clicking on it.
The computer dismounts the disk drive
and notify you when it is safe to remove
the volume.

Mounting FireWire Disk Drives 
(Macintosh)
NOTE: Even if your FireWire disk drive was bought
for use on a Macintosh, you MUST first partition and
format the drive as a FAT32 volume on the FS-2/2E
for it to work.

STEP 1: On a Macintosh, start your computer
and connect your FireWire disk drive to
the computer utilizing a standard 6-pin
to 6-pin FireWire cable. 
Consult your FireWire disk drive docu-
mentation for more information. 

STEP 2: Ensure the required FireWire disk drive
drivers have also been loaded onto you
computer system (consult your
FireWire disk drive's documentation for
more information). 

SAFELY REMOVE
HARDWARE
ICON
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When mounted, your FireWire disk
drive should appear on the computer's
desktop as shown below:

The FireStore formatted disk drive
appears as a FAT32 volume with a PC
label. 
NOTE: This is not always the case on
Version 10 of the Macintosh operating
system however.

STEP 3: Once you have located your FireWire
disk drive on the desktop, double click
the disk icon to open it up. Once
opened, you will see the following:

Dismounting FireWire Disk Drives 
(Macintosh)
Once you have completed working with your disk
drive on a Macintosh computer system, you must
dismount the drive before unplugging it. 

Do this as follows:

STEP 1: Select the disk drive on the computer's
desktop. It is marked with a PC symbol. 

STEP 2: Drag the drive into the trash. This
dismounts the particular disk drive.

Creating a Playlist
Use the following procedure to create a simple
playlist on the FS-2/2E.

STEP 1: Ensure no playlist is open. 
STEP 2: TO ADD A CLIP - Play a clip you wish

to add to the playlist. Using the front
panel buttons, press MARK IN and
MARK OUT for the particular portion of
the clip to add to the playlist. Both
buttons will light.

STEP 3: Once marked, press the front panel
PLAYLIST button. The MARK IN and
MARK OUT key lights will go out. 

STEP 4: Navigate to the next clip and again
mark in and out points followed by
pressing PLAYLIST. 

STEP 5: Repeat steps 2 and 3 to add all desired
clips. 

STEP 6: Once you have selected all the clips
you wish to add to the playlist, stop
playback and navigate to the
PLAYLIST menu on the FS-2/2E.

STEP 7: Select SAVE and name the playlist. (It
is also possible to modify your created
playlist using the PLAYLIST-> EDIT
menu.

STEP 8: To playback the playlist, navigate to
PLAY-FROM in the FS-2/2E menu and
select PLAYLISTS. Select the desired
playlist and then exit. The PLAYLIST
button on the front panel will light.

All playback now comes only from the created
playlist. 
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How to Mark Scenes
The FS-2/2E Scene Marking feature allows you to
mark clips for placement in particular folders during
recording, playback or stop mode. 

When a drive is formatted using FireStore, ten
folders are created numbered 0 through 9. After the
drive is formatted on FireStore, you can connect the
hard-disk drive to a computer and give each of
these folders a custom name (if you need help
mounting your FireWire hard-disk drive to your
computer system, refer to “How to Put Recorded
Clips on a Computer System” on page 2-2. To
rename each folder, click on the folder name until it
is highlighted, then type in the desired name of the
folder.

NOTE: Folder names cannot exceed eleven
characters. 

Folders are ordered on FireStore in numerical
followed by alphabetical order. For instance, if
folders are named “Scene 1”, “Scene 2” and
“Auditions”, they appear on FireStore as “1
Auditions”, “2 Scene 1” and 2 Scene 2”. The folder
number is added in front of the folder name on the
FS-2/2E LCD display for easy identification when
using the optional remote control commander
keypads.

To create a custom order to Folders, Focus
Enhancements recommended that you change the
name to change the numerical/alphabetical order.

For example place numbers at the beginning of the
folder name to determine the key to folder
assignments.

After you have selected your “mark to” folder, you
are almost ready to mark your scenes. Before you
can start marking, you must select the playlist that
will contain your scenes. To do this, use the
following steps:

STEP 1: Press the PLAYLIST button to bring up
the playlist menu. 

STEP 2: Select either OPEN, to choose an
existing playlist, or NEW, to create a
new one. 

STEP 3: Exit the PLAYLIST menu by pressing
the MENU button

Now you are ready to mark your scenes. Use the
following procedure:

STEP 1: Play your pre-recorded clip from the
FS-2/2E.

STEP 2: When you encounter the start of your
scene, pause the FS-2/2E and then
press the MARK IN button. The MARK
IN button should light up. 

STEP 3: Play your clip again to the end point
and pause. 

STEP 4: Press MARK OUT. The MARK OUT
button lights. 

STEP 5: Press the PLAYLIST button to save the
marked scene. 

STEP 6: Mark the rest of your scenes using the
same procedure.

STEP 7: When you have completed marking
your scenes, you must save the playlist
to disk. Stop the playback on the 
FS-2/2E and press PLAYLIST. 

STEP 8: Select the SAVE menu option, enter
the playlist name.

STEP 9: Press NEXT, and then press YES to
confirm your request to save the
playlist. The playlists are saved in the
PLAYLIST folder on your hard drive.

Advanced users can delete or change the order of
scenes using the PLAYLIST->EDIT menu options.
For FS-2E users, or FS-2 (with 2.0 upgrade), you
can also use the web interface (shown below) to
edit the current playlist. Use your browser to
connect to the FS-2E, and select the PLAYLIST
tab.
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If the FS-2/2E PLAY FROM is set to “TRACKLIST”
the name of the SCENE MARK, or assigned, folder
appears without brackets on the LCD display (for
example, 2 SCENE 2).

If the PLAY FROM menu is set to “FOLDERS”, the
name of the assigned folder appears in brackets on
the LCD display (for example, 2 <SCENE 2>.

Using the SCENE MARK menu, you can assign
clips to folders using the numeric keypad on the
optional remote control unit. To add all assigned
clips to their respective folders on the disk drive,
select UTILITIES>ORGANIZE CLIP from the 
FS-2/2E menu. 

Once complete, an additional file is added to the
disk named “grade” and files are moved to the
selected folder for easy access on an NLE system.

Do not delete the file named “grade” from the disk if
you intend to use the disk on FireStore again.

Connecting the FS-2/2E to a 
Network
You can connect the FS-2/2E to a network using the
10/100 Base T Ethernet port on the rear panel. Do
this as follows:

STEP 1: Use a standard RJ85 cable to connect
between the Ethernet port on the rear
panel to a network. 

STEP 2: Power up the FS-2/2E and make sure
your network is functioning properly.
Contact your system administrator for
additional help.

STEP 3: Navigate to the FS-2/2E NETWORK
menu (SETUP>NETWORK SETUP).
Once in the menu, open the IP
SETTINGS sub menu. 

STEP 4: Select either DHCP (network supplies
the IP address) or CUSTOM IP (you
enter the IP address, Sub Net Mask
and Gateway). Exit once complete.

STEP 5: If your network requires a user name or
password, navigate to USER/
PASSWORD and enter both. 

STEP 6: Exit the NETWORK SETTINGS menu
and the FS-2/2E attempts to log onto
the network. 

Make sure the services you intend to use are
enabled. These are enabled using 
SETUP>NETWORK SETTINGS >SERVICES.

n STOP  1-1001
COUNTER
00:00:00:00
DISK 1 184 min

<2SCENE 2>
MENU DISP SHFT
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CHAPTER 4
REFERENCE

This chapter contains reference information for the
FS-2/2E as follows:

Technical Specifications
FS-2/2E LCD Display Modes
Supported RS422 Commands
Shuttle Speed Parameters
Jog Speed Parameters
Custom Commands

Technical Specifications
Input/Outputs
Component - Y, Pr, Pb (3 x BNC in, 3 x BNC out) 

if Component SMPTE:
• 100% white at 700mv with 300mv 

Sync
• 700mv Chroma levels (100% color 

bars)
• Setup default to OFF
• Chroma offset default to OFF 
If Component Betacam
• 100% white is at 714mv with 

286mv Sync
• 4/3 Chroma boost to 934mv p to p
• Setup default to ON
If Component MII:
• 100% white is at 700mv with 

300mv Sync
• Black to White range is restricted 

to 647mv (700-setup)
• Setup is ON

Sync (1 x BNC in, 1 x BNC out) 
Composite (1 x BNC in, 1 x BNC out) 
Monitor Video Out - Composite (1 x BNC) 
General Composite Specifications
Differential Phase 2 Degree maximum

Differential Gain 2% maximum

Hue Accuracy 1 Degree

Signal/Noise Ratio Greater than 54 dB

Bandwidth 5.5 MHz

K Factor % @ 2T 1 % maximum

Y/C Delay Less than 25 nS

Subcarrier locking range 100Hz

Subcarrier free-run frequency +/- 30 Hz (NTSC or
PAL Fsc deviation

Genlock Horizontal 
adjustment range + 4 uS

Residual Subcarrier Less than 0.5 IRE

SC Phase Less than 2 degrees

S-Video - Y/C (1 x 4-pin DIN in, 1 x 4-pin DIN out) 
Levels Adjustments
Video Gain - +/- 20% 2mv resolution

Chroma Gain - +/- 20% 2mv resolution

Setup ON adds 7.5 IRE, or 53mv to
luminance channel

OFF no change to luminance
channel

Serial Digital - SD-SDI (1 x BNC in, 1 x BNC out)
- conforms to the SMPTE 259M standard 

The FS-2E outputs embedded audio in
the SDI output stream. This feature is
only available for the FS-2E.

Timecode (1 x BNC in, 1 x BNC out) 
Balanced Audio (2 x XLR in, 2 x XLR out) Stereo
Audio Monitor (1 x 1/4” TRS jack) 
General Audio Specifications
Balanced Inputs
Input Impedance 600 Ohms +/-10
Ohms

Quantization 16 bits 48Khz

Common mode rejection @1 KHz (dB)100 dB

Analog Input adjustment range -34dB to +4.5dB (in
1.5dB steps, default setting 0dB)

Amplitude with no clipping 3.5Vp-p
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Balanced Outputs
THD@1 Khz Less than 0.05%

Channel Separation 100 dBu 
@ 1 Khz 70 dB

SNR 82 db, A weighted

Quantization 16 bits 48Khz

Output Impedance 600 Ohms +/-10
Ohms

Bandwidth at -3dB points 24Khz

Headphone Output (1 x 1/4” TRS jack w/ level
control) 
Headphone adjustment range  -73dBdB to +4.5dB

Headphone Output Impedance32 Ohms, 32mW

AES/EBU Digital Audio (1 x XLR in, 1 x XLR out) 
Reference Video Loop Through (2 x BNC) 
DV Video I/O - 25 Mb/s (1 x 6-pin IEEE-1394) 
DV Video Pass Through - up to 400 Mb/s (1 x 6-
pin IEEE-1394) 
External HDD I/O - up to 400 Mb/s (1 x 6-pin
IEEE-1394) 
FireWire Computer I/F (1 x 6-pin IEEE-1394) 
10/100 Base T Ethernet 

Control 
GPI & RS-232C Control (1 x 3.5mm
mini jack) 
RS-422 (1 x DB9 Serial) 

Power 
110V to 220V AC, 50 - 60 Hz, Auto
Ranging 100W 
IEC Power Input 

Physical Specification 
18.41lbs (8.36kg) 
19" x 17.3" x 3.5" (483mm x 440mm x
89mm) 

Audio/Video/Timecode Specification 
25Mb/s, 8-bit 4:1:1 (NTSC-DV) or
4:2:0 (PAL-DV) video (user switchable) 
SMPTE or DV embedded or External
Timecode (Drop or Non Drop) 
2-ch., 16-bit embedded Digital Audio 

DTE File Formats 
FS-2 and FS-2E: RawDV (.dv), AVI Type 1, AVI
Type 2, Canopus AVI and Matrox AVI (.avi),
QuickTime (.mov), Pinnacle (.avi) or Avid DV-OMF
(.omf) 

FS-2E (or FS-2 with 2.0 upgrade): 24P AVI Type 2,
and 24P Quicktime.

Disk Information 
Internal Disk Type: 120 GB, IDE, 7200
RPM 
External Disk Type: User Supplied
IEEE-1394a FireWire 
Disk Format: FAT32 
FAT32 FireWire HDD compatible with
Windows 98SE, ME, 2000, XP and
Mac OS9 and OSX Compliance and
Warranty 
CE, C-Tick and FCC 
2-Year Limited Warranty 

Compatible DV Formats 
DV, MiniDV, DVCam and DVCPro 
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FS-2/2E LCD Display Modes
The table below shows LCD characteristics when
used with different FS-2/2E control, record, play
and stop modes:

PLAY/REC MODE FS-2/2E LCD
Stop STOP 

Pause ll PLAY 

Play > PLAY 

Rec (Pause) ll REC 

Normal Rec (Rec) REC 

Retro Disk (Stop) L STOP 

Retro Disk (Standby) L REC 

Retro Cache (Stop) C STOP 

Retro Cache (Standby) C REC 

Loop Record (Stop) O STOP 

Loop Record (Standby) O REC 

Loop Record (Rec) O REC 

Snap (Stop) STOP 

Snap (Standby) ll SNAP 

Snap (Rec) ll SNAP 

Time Lapse (Stop) STOP 

Time Lapse (Pause) ll T REC 

Time Lapse (Rec) T REC 

CONTROLTYPE FS-2/2E LCD 
AV/C* (Stop) A STOP 

AV/C* (Rec Pause) ll A <REC TYPE> REC 

AV/C* (Rec) A <REC TYPE> REC 

AV/C* (Play Pause) ll A PLAY 

AV/C* (Play) A ALL 

Syncro Slave (Pause) ll Y <REC TYPE>REC 

Syncro Slave (Rec) Y <REC TYPE>REC 

* AV/C is only for use when the FS-2/2E is
connected to a computer system. To control the FS-
2/2E from a camcorder, use Syncro Slave mode.

Supported RS422 Commands
Shuttle FWD  21, 13, Shuttle Speed

Shuttle Rev  21, 23, Shuttle Speed

Jog FWD  21, 11, Jog Speed

Jog Rev  21, 21, Jog Speed

Stop  20, 00

Play  20, 01

Pause  21, 13, 0

Record  20, 02

Goto Timecode 24, 31, timecode

Shuttle Speed Parameters
Pause         -     0

Play Slow 6   - 1 to 100

Play Slow 5   - 101 to 200

Play Slow 4   -   201 to 300

Play Slow 3   -   301 to 400

Play Slow 2   -   401 to 500

Play Slow 1   -   501 to 999

Play Normal   -  1000 to 1999

Play Fast 1   - 2000 to 2999

Play Fast 2   -  3000 to 3999

Play Fast 3   -  4000 to 4999

Play Fast 4   -  5000 to 5999

Play Fast 5   -  6000 to 6999

Play Fast 6   -  7000 to 7999

Play Fastest  -  8000 to 8999

Jog Speed Parameters
Pause         -     0

Step 1 Frame -     1 to 200

Play Slow 4   -   201 to 300

Play Slow 3   -   301 to 400

Play Slow 2   -   401 to 500

Play Slow 1   -   501 to 800

Play Normal   - 1000 to 8999
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Custom Commands
The following commands are currently supported.

Warnings!!
No feedback occurs indicating that the
command was processed
successfully.
The FS2/2E must be in STOP mode
before sending these commands
Only positive values of contrast,
saturation, H phase, SC phase, hue,
and brightness are allowed
When deleting multiple tracks, delete
the last track first, then work your way
to the first track. A delete command
causes the track list to be re-built.
Shifting all tracks up.
Send the CSUM command at the end
of each command

24 31 ## ## ## ## - Goto TimeCode from start 
of track
48 80 82 2A ## 00 00 00 00 00     - Goto Track ##   (Note 0 = 
track #1)
48 80 82 06 ## 00 00 00 00 00     - Delete Track ##
48 80 82 0A 00 00 00 00 00 00     - Record Mode     - Normal
48 80 82 0A 01 00 00 00 00 00     - Record Mode     - retro disk
48 80 82 0A 02 00 00 00 00 00     - Record Mode     - retro cache
48 80 82 0A 03 00 00 00 00 00     - Record Mode     - loop record
48 80 82 0A 04 00 00 00 00 00     - Record Mode     - still record
48 80 82 0A 05 00 00 00 00 00     - Record Mode     - time lapse
48 80 82 0B 00 00 00 00 00 00     - Snap Mode       - Same File
48 80 82 0B 01 00 00 00 00 00     - Snap Mode       - New File
48 80 82 0C 00 00 00 00 00 00     - Control Mode    - Local Control
48 80 82 0C 01 00 00 00 00 00     - Control Mode    - Remote 
Control
48 80 82 0C 02 00 00 00 00 00     - Control Mode    - AVC Control
48 80 82 0C 03 00 00 00 00 00     - Control Mode    - Syncro Slave 
Control
48 80 82 0D 00 00 00 00 00 00     - Play Mode       - Play Clip 
(normal)
48 80 82 0D 01 00 00 00 00 00     - Play Mode       - Loop Clip
48 80 82 0D 02 00 00 00 00 00     - Play Mode       - Loop All
48 80 82 0D 03 00 00 00 00 00     - Play Mode       - Play All
48 80 82 0E 00 00 00 00 00 00     - Play From       - Play List
48 80 82 0E 01 00 00 00 00 00     - Play From       - Track List
48 80 82 0E 02 00 00 00 00 00     - Play From       - Grade List
48 80 82 0F 00 00 00 00 00 00     - Record Format   - Raw DV
48 80 82 0F 01 00 00 00 00 00     - Record Format   - AVI TYPE 1
48 80 82 0F 02 00 00 00 00 00     - Record Format   - AVI TYPE 2

48 80 82 0F 03 00 00 00 00 00     - Record Format   - CANOPUS 
AVI
48 80 82 0F 04 00 00 00 00 00     - Record Format   - MATROX 
AVI
48 80 82 0F 05 00 00 00 00 00     - Record Format   - QUICKTIME
48 80 82 0F 06 00 00 00 00 00     - Record Format   - AVID OMF
48 80 82 0F 07 00 00 00 00 00     - Record Format   - PINNACLE
48 80 82 0F 0B 00 00 00 00 00     - Record Format   - AVI TYPE 
2 - 24P
48 80 82 0F 0C 00 00 00 00 00     - Record Format   - QUICKTIME 
- 24P
48 80 82 10 00 00 00 00 00 00     - FTP             - ENABLE
48 80 82 10 01 00 00 00 00 00     - FTP             - DISABLE
48 80 82 11 00 00 00 00 00 00     - TELNET          - ENABLE
48 80 82 11 01 00 00 00 00 00     - TELNET          - DISABLE
48 80 82 12 00 00 00 00 00 00     - OSD             - OFF
48 80 82 12 01 00 00 00 00 00     - OSD             - MENU
48 80 82 12 02 00 00 00 00 00     - OSD             - TC
48 80 82 12 03 00 00 00 00 00     - OSD             - ABS
48 80 82 16 00 00 00 00 00 00     - GPI             - OFF
48 80 82 16 01 00 00 00 00 00     - GPI             - PAUSE
48 80 82 16 02 00 00 00 00 00     - GPI             - INDEX
48 80 82 16 03 00 00 00 00 00     - GPI             - SNAP
48 80 82 17 00 00 00 00 00 00     - Backlight       - OFF
48 80 82 17 01 00 00 00 00 00     - Backlight       - ON
48 80 82 17 02 00 00 00 00 00     - Backlight       - AUTO
48 80 82 18 00 00 00 00 00 00     - Audio Correction- OFF

48 80 82 18 01 00 00 00 00 00     - Audio Correction- MEDIUM

48 80 82 18 02 00 00 00 00 00     - Audio Correction- HIGH

48 80 82 19 00 00 00 00 00 00     - TimeCode Mode   - External 

48 80 82 19 01 00 00 00 00 00     - TimeCode Mode   - Rec Run

48 80 82 19 02 00 00 00 00 00     - TimeCode Mode   - Regen

48 80 82 19 03 00 00 00 00 00     - TimeCode Mode   - Free Run

48 80 82 1A 00 00 00 00 00 00     - Clip Preview    - On

48 80 82 1A 01 00 00 00 00 00     - Clip Preview    - Off

48 80 82 1A 02 00 00 00 00 00     - Clip Preview    - None

48 80 82 1A 03 00 00 00 00 00     - Clip Preview    - Custom

48 80 82 1B ## 00 00 00 00 00     - Brightness      - ##

48 80 82 1C 00 00 00 00 00 00     - Input Select    - Cmpst

48 80 82 1C 01 00 00 00 00 00     - Input Select    - Y/C

48 80 82 1C 02 00 00 00 00 00     - Input Select    - CMPNT

48 80 82 1C 03 00 00 00 00 00     - Input Select    - SDI

48 80 82 1C 04 00 00 00 00 00     - Input Select    - DV

48 80 82 1D 00 00 00 00 00 00     - Audio Rec Level -   -34.5

48 80 82 1D 01 00 00 00 00 00     - Audio Rec Level -   -33.0

48 80 82 1D 02 00 00 00 00 00     - Audio Rec Level -   -31.5

48 80 82 1D 03 00 00 00 00 00     - Audio Rec Level -   -30.0

48 80 82 1D 04 00 00 00 00 00     - Audio Rec Level -   -28.5
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48 80 82 1D 05 00 00 00 00 00     - Audio Rec Level -   -27.0

48 80 82 1D 06 00 00 00 00 00     - Audio Rec Level -   -25.5

48 80 82 1D 07 00 00 00 00 00     - Audio Rec Level -   -24.0

48 80 82 1D 08 00 00 00 00 00     - Audio Rec Level -   -22.5

48 80 82 1D 09 00 00 00 00 00     - Audio Rec Level -   -21.0

48 80 82 1D 0A 00 00 00 00 00     - Audio Rec Level -   -19.5

48 80 82 1D 0B 00 00 00 00 00     - Audio Rec Level -   -18.0

48 80 82 1D 0C 00 00 00 00 00     - Audio Rec Level -   -16.5

48 80 82 1D 0D 00 00 00 00 00     - Audio Rec Level -   -15.0

48 80 82 1D 0E 00 00 00 00 00     - Audio Rec Level -   -13.5

48 80 82 1D 0F 00 00 00 00 00     - Audio Rec Level -   -12.0

48 80 82 1D 10 00 00 00 00 00     - Audio Rec Level -   -10.5

48 80 82 1D 11 00 00 00 00 00     - Audio Rec Level -   - 9.0

48 80 82 1D 12 00 00 00 00 00     - Audio Rec Level -   - 7.5

48 80 82 1D 13 00 00 00 00 00     - Audio Rec Level -   - 6.0

48 80 82 1D 14 00 00 00 00 00     - Audio Rec Level -   - 4.5

48 80 82 1D 15 00 00 00 00 00     - Audio Rec Level -   - 3.0

48 80 82 1D 16 00 00 00 00 00     - Audio Rec Level -   - 1.5

48 80 82 1D 17 00 00 00 00 00     - Audio Rec Level -     0.0

48 80 82 1D 18 00 00 00 00 00     - Audio Rec Level -   + 1.5

48 80 82 1D 19 00 00 00 00 00     - Audio Rec Level -   + 3.0

48 80 82 1D 1A 00 00 00 00 00     - Audio Rec Level -   + 4.5

48 80 82 1E 00 00 00 00 00 00     - High Res Mode   -   Disable

48 80 82 1E 01 00 00 00 00 00     - High Res Mode   -   Enable

48 80 82 1F 00 00 00 00 00 00     - Folder Pref     -   Scene Mark

48 80 82 1F 01 00 00 00 00 00     - Folder Pref     -   Auto Mark

48 80 82 20 00 00 00 00 00 00     - Reference Video -   Reference

48 80 82 20 01 00 00 00 00 00     - Reference Video -   Free Run

48 80 82 21 00 00 00 00 00 00     - Analog Out      -   Composite

48 80 82 21 01 00 00 00 00 00     - Analog Out      -
COMPONENT-SMPTE

48 80 82 21 02 00 00 00 00 00     - Analog Out      -
COMPONENT-BETACAM

48 80 82 21 03 00 00 00 00 00     - Analog Out      -
COMPONENT-MII

48 80 82 22 01 00 00 00 00 00     - Organize        -   PINNACLE

48 80 82 22 02 00 00 00 00 00     - Organize        -   CLIPS

48 80 82 22 03 00 00 00 00 00     - Organize        -   OMF

48 80 82 23 ## 00 00 00 00 00     - Contrast        -   ##

48 80 82 24 ## 00 00 00 00 00     - Saturation      -   ##

48 80 82 25 ## 00 00 00 00 00     - H Phase         -   ##

48 80 82 26 ## 00 00 00 00 00     - SC Phase        -   ##

48 80 82 27 ## 00 00 00 00 00     - Hue             -   ##

48 80 82 28 00 00 00 00 00 00     - Black Level     -     0 IRE

48 80 82 28 01 00 00 00 00 00     - Black Level     -   7.5 IRE
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INDEX

A
absolute timecode value 2-5
AES/EBU input/output 1-7
air temperature 1-3
analog out 2-26
applications 1-2
audio correction 2-26
audio input levels 2-22
audiometer 2-6
AV/C 2-13
available space indicator 2-6
Avid DV OMF file format, editing 3-4

B
back index key 2-3
back search key 2-4
backlight 2-25
balanced analog audio input/output 1-7
BVW-75 2-21

C
component inputs/outputs 2-29
component video (Y, R-Y, B-Y) key 2-2
composite input/output 1-6
composite video source input key 2-2
control mode menu 2-12
current disk volume 2-6
current system status 2-5

D
default audio input 2-22
default menu screen 2-5
delete clip 2-31
delete list 2-18
DHCP 2-28
diagnostics 2-32
disk drive bay 1-5
disk drive, external 1-4
dismounting FireWire drives 3-5
DISP 2-6
display soft keys 1-5
DTE disk recorder 1-1
DV video source input key 2-2

E
edit buttons 2-1
edit function keys 2-1
E-E key 2-2
Ethernet connector 1-6

F
factory reset 2-32
FF/RW Hi Res 2-24
file name 2-32
FireStore FS-2/2E, features 1-1
folder display 2-6
folder key 2-1
folder list 2-15
folder pref menu 2-26
format disk 2-31
formatting drives 1-9
forward index key 2-3
forward search key 2-4
FREE RUN Mode 2-23
front control panel 1-5
fuse replacement 1-10

G
GPI plug 1-6
GPI port 2-25

H
HDD bypass key 2-2
headphones 1-5

I
IDE drive, inserting 1-3
index at scene 2-12, 2-13
index at TC 2-12, 2-13
input buttons 2-1
input source selection keys 2-2
installation 1-3
internal HDD function 2-18

K
keeper key 2-1
keypad lock key 2-2

L
LCD display 1-5, 2-4
LCD display soft keys 2-3
local 2-12
lock handle 1-4
loop all 2-14
loop clip 2-14
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loop record 2-11

M
MARK IN key 2-1
MARK OUT key 2-1
MENU 2-6
MENU key 2-3
menu system 2-7
mounting FireWire disks 3-3

N
network connection 3-8
network setup 2-27
normal record 2-9

O
on screen display 2-2
organize clip 2-30
organize OMF 2-30
organize Pinnacle 2-30
OS upgrade 2-20
OSD 2-2

P
package contents 1-2
partition disk drives 2-31
password/username 2-28
Pb input/output 1-7
PINN 2-30
play all 2-14
play clip 2-14
play from mode menu 2-15
play key 2-3
play list 2-15
play mode menu 2-14
play/record status symbol 2-5
playback, how to 3-2
playlist key 2-1
playlist menu 2-15
playlist, creating 3-6
power connection 1-7
power module, fuse replacement 1-10
power switch 1-5
Pr input/output 1-7
preferences 2-26

R
rack mounting 1-3
rear panel 1-6
REC RUN Mode 2-23
record format menu 2-19

record key
red record key 2-3

RECORD MENU 2-9
record/play status indicator 2-5
recorded clips on disk drive, putting 3-2
recording, making a 3-2
reference video 1-7
REGEN Mode 2-23
remote 2-12
REMOTE key 2-2
remote operation 2-21
repair disk 2-32
restore system preferences 2-26
retro cache 2-10
retro disk 2-9
RS422 control 1-6
RS422 menu 2-21

S
scenes, marking 3-7
SDI input 1-6
SDI output 1-6
SDI video input key 2-2
services (internet) 2-28
set date and time 2-19
set timecode 2-23
setting up the FS-2/2E 1-8
SHFT 2-6
SHIFT key 2-3
site requirements 1-3
soft key one 2-6
soft key three 2-6
soft key two 2-6
soft keys 1-5, 2-9
software updates 1-1
still 2-11
stop key 2-3
storage temperature 1-3
S-Video (Y/C) key 2-2
Sync input/output 1-7
system preferences 2-26

T
TC delay 2-24
TC options 2-22
technical support 1-1
time and date setting 1-9
time lapse 2-12
timecode input/output 1-7
timecode options 2-22
timecode/user bit display mode 2-5
timecode/user bit value 2-6
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track list 2-15
transport control keys 1-5, 2-3

U
Unpacking 1-2
updates, software 1-1
upgrade operating system 2-20
user bit 2-5
username/password 2-28
utilities menu 2-29
utility buttons 2-1
utility function keys 2-2

V
video monitor output 1-6
video out adjustment menu 2-29
view IP information 2-28
volume number 2-5

Y
Y/C input 1-6
Y/C output 1-6
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